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IMPORTANT! Before using this product, read and understand the information in the “Safety” appendix
in this document.

Product description

The CLA Identifiler™ Plus and Identifiler™ Direct PCR Amplification Kits are 5-dye, 16-locus short
tandem repeat (STR) analysis kits with 1 sex-discriminating marker.

* Both kits amplify the same loci as the AmpF2STR™ Identifiler™ PCR Amplification Kit.
* The CLA Identifiler™ Plus kit uses genomic DNA.

* The CLA Identifiler™ Direct kit uses cells spotted on a NUCLEIC-CARD™ matrix. This kit does not
require DNA extraction or purification.

* Both kits are compatible with all cell line databasing loci standards and global databasing loci
standards.

Use in HSA and MSA

Cell line authentication using STR analysis kits can be used for human sample authentication (HSA) and
mixed sample analysis (MSA).

* In HSA, you can use the kits to verify the DNA profile of the sample or to perform a quality check.

* In MSA, you can use the kits to deconvolute the presence of multiple contributors in a sample
(chimerism) by identifying more than one DNA genotype in the sample.

Related products

The CLA GlobalFiler™ PCR Amplification Kit is a 6-dye, 24-locus short tandem repeat (STR) analysis kit
with 3 sex-discriminating markers. The kit uses genomic DNA. It provides reduced amplification time
and increased discrimination power compared to the AmpFZSTR™ Identifiler™ Plus and AmpF{STR™
Identifiler™ Direct PCR Amplification Kits.

CLA Identifiler™ Plus and Identifiler™ Direct PCR Amplification Kits User Guide 7
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Identifying the presence of contaminating cells in a culture

One objective of cell line authentication is to determine whether a cell line is contaminated with
unrelated cells. Because contaminating cells are likely to have a different STR profile than the parent cell
line, use of CLA STR kits is a useful tool to flag the presence of contamination.

In a mixture of cell lines, the final DNA profile reflects the genomic makeup of all cells present.
Therefore, data must be examined carefully.
* One peak at a locus could represent:
— Homozygous parent cell DNA
— Homozygous parent cell and homozygous contaminating cell DNA
— Homozygous parent cell DNA and a deletion at the locus for contaminating cell DNA
* Two peaks at a locus could represent:
— Heterozygous parent cell DNA

— Both cell types homozygous for different loci
— Both cell types heterozygous for the same loci

* Three or more peaks at a locus could represent:

— Mixture of two cell types, with one homozygous for one allele, the other heterozygous for
different alleles

— Three or more different cell lines

— Drift of a cell line's allelic make-up over continual passage

— A combination of the above
The interpretation of aberrant peaks at a single locus can be challenging and ambiguous. However, with
the analysis of 16 loci and 1 sex-discriminating marker in the CLA Identifiler™ Plus and Identifiler™ Direct
PCR Amplification Kits, it can be possible to identify distinct peaks that clearly point to the presence

of a contaminating cell line, even if the genomic makeup of the contaminating cell line is not fully
discernible.

Dyes used in the kits

Table 1 CLA Identifiler™ Plus and Identifiler™ Direct PCR Amplification Kits dyes

Dye Color Label
6-FAM™ Blue Sampiles, allelic ladders, and controls
vic™ Green
NED™ Yellow
PET™ Red
Liz™ Orange GeneScan™ 600 LIZ™ Size Standard v2.0

8 CLA Identifiler™ Plus and Identifiler™ Direct PCR Ampilification Kits User Guide
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Loci amplified by the kits

Table 2 CLA Identifiler™ Plus and Identifiler™ Direct PCR Amplification Kits loci and alleles

Locus Chromosome . . . DNA Control
designation location Alleles included in the allelic ladder Dye label 9947A
D8S1179 8 8,910, 11,12, 13, 14, 15,16, 17, 18, 19 6-FAM™ 13,13
D21511 21g11.2-g21 24,24.2,25, 26, 27, 28, 28.2, 29, 29.2, 30, 30, 30
30.2, 31, 31.2, 32, 32.2, 33, 33.2, 34, 34.2, 35,
35.2, 36, 37, 38
D7S820 7911.21-22 6,7,8,9,10,11,12,13, 14,15 10, 11
CSF1PO 5033.3-34 6,7,8,9,10,11,12,13,14, 15 10, 12
D3S1358 3p 12,13, 14,15, 16,17, 18, 19 vic™ 14,15
THO1 11p15.5 4,5,6,7,8,9,9.3,10, 11, 13.3 8,9.3
D13S317 13022-31 8,9,10,11,12,13, 14, 15 11, 11
D16S539 16924.gter 5,8,9,10,11,12,13, 14, 15 11,12
D2S1338 2qg35-37.1 15,16, 17,18, 19, 20, 21, 22, 23, 24, 25, 26, 19, 23
27,28
D19S433 19912-13.1 9,10, 11,12,12.2,13,13.2, 14,14.2, 15,15.2, | NED™ 14,15
16, 16.2,17,17.2
VWA 12p12-pter 11,12, 13, 14, 15,16, 17, 18, 19, 20, 21, 22, 17,18
23, 24
TPOX 2p23-2per 6,7,8,9,10,11,12,13 8,8
D18S51 18921.3 7,9,10,10.2, 11, 12,13, 13.2, 14, 14.2, 15, 15,19
16,17, 18,19, 20, 21, 22, 23, 24, 25, 26, 27
Amelogenin X:p22.1-223Y: | XY PET™ X
p11.2
D5S818 5921-31 7,8,9,10,11,12,13, 14,15, 16 11, 11
FGA 4928 17,18, 19, 20, 21, 22, 23, 24, 25, 26, 26.2, 27, 23,24
28, 29, 30, 30.2, 31.2, 32.2, 33.2, 42.2, 43.2,
44.2,45.2,46.2,47.2,48.2,50.2, 51.2
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Standards and controls that are required

The CLA Identifiler™ Plus and Identifiler™ Direct PCR Amplification Kits require the following standards
and controls for PCR amplification, PCR product sizing, and genotyping:

v2.0

page 12.

for PCR products. See “GeneScan™ 600 LIZ™ Size Standard v2.0” on

Item Description Included in
B the kits

DNA Control 9947A | A positive control for evaluating the efficiency of the amplification step
and STR genotyping of the kit allelic ladder. See “DNA Control 9947A Yes
profile” on page 10.

Allelic ladder Developed for accurate characterization of the alleles amplified in the
kit. The allelic ladder allows automatic genotyping of most of the Yes
reported alleles for the loci in the kit. See “Loci amplified by the kits”
on page 9 and “Allelic ladder profile” on page 11.

GeneScan™ 600 Used for obtaining sizing results. This standard, which has been

LIZ™ Size Standard | evaluated as an internal size standard, yields precise sizing results Yes

DNA Control 9947A profile
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GeneScan™ 600 LIZ™ Size Standard v2.0
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Figure 3 GeneMapper™ Software plot of the GeneScan™ 600 LIZ™ Size Standard v2.0
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Contents and storage

CLA Identifiler™ Plus kit contents and storage

Chapter 1 Product information ~ S#88

Contents and storage

The CLA Identifiler™ Plus kit contains sufficient quantities of the reagents for 200 amplification reactions
at 25 pL/reaction.

IMPORTANT! The fluorescent dyes attached to the primers are light-sensitive. Protect the primer mix,
amplified DNA, allelic ladder, and size standard from light when not in use.

IMPORTANT! Do not refreeze kit components after thawing.

Item

Description

Amount

200 reactions
(Cat. No. A65672)

Storagel'l

Identifiler™ Plus Contains enzyme, salts, dNTPs, 2x1.0mL -25°C to —15°C on receipt.
. . : o .
Master Mix cazler protein, and 0.04% sodium 2-8°C after first use, up to the
azige. expiration date stated on the Kkit.
AmpFESTR™ Contains 0.1 ng/pL human female 1 x 300.0 pL
Control DNA 9947A | 9947A genomic DNA from cell line in
0.05% sodium azide and buffer.[?!
See “DNA Control 9947A profile” on
page 10.
Identifiler™ Plus Contains forward and reverse 1x1.0mL —25°C to —15°C on receipt.
Primer Mix tprlme;rs to amplify human DNA 2-8°C after first use, up to the
argets. expiration date stated on the Kkit.
Identifiler™ Plus Contains amplified alleles. 1 x 50.0 pL Store protected from light.
Allelic Ladder See “Allelic ladder profile” on
page 11.
GeneScan™ 600 Contains 36 single-stranded labeled 2 x 200 yL 2-8°C, protected from light.

LIZ™ Size Standard
v2.0

fragments of: 20, 40, 60, 80, 100,
114, 120, 140, 160, 180, 200, 214,
220, 240, 250, 260, 280, 300, 314,
320, 340, 360, 380, 400, 414, 420,
440, 460, 480, 500, 514, 520, 540,
560, 580, and 600 nucleotides.

(~800 reactions)

Do not freeze.

[ See packaging for expiration date. Do not use expired product.

2 DNA Control 9947A is included at a concentration that is appropriate for use as an amplification control (that is, to provide confirmation of
the capability of the kit reagents to generate a profile of expected genotype). It is not designed for use as a DNA quantification control. If you
quantify aliquots of Control 9947A, the concentration may differ from the labeled concentration.

CLA Identifiler™ Plus and Identifiler™ Direct PCR Amplification Kits User Guide
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EF#E  Chapter 1 Product information
Required materials not supplied
CLA Identifiler™ Direct kit contents and storage

The CLA Identifiler™ Direct kit contains sufficient quantities of the reagents for 200 amplification
reactions at 25 plL/reaction.

IMPORTANT! The fluorescent dyes attached to the primers are light-sensitive. Protect the primer mix,
amplified DNA, allelic ladder, and size standard from light when not in use.

IMPORTANT! Do not refreeze kit components after thawing.

Amount
. . 1
Item Description 200 reactions Storagel'!
(Cat. No. A65908)
Identifiler™ Direct Contains enzyme, salts, dNTPs, 2x1.25mL —25°C to —15°C on receipt.
. . . o .
Master Mix carct;ler protein, and 0.04% sodium 2-8°C after first use, up to the
azide. expiration date stated on the kit.

AmpF{STR™ Contains 0.1 ng/pL human female 1 x50.0 L

Control DNA 9947A | 9947A genomic DNA from cell line
in 0.05% sodium azide and bufferl?]

See “DNA Control 9947A profile” on

page 10.
Identifiler™ Direct Contains forward and reverse 2x1.25mL —25°C to -15°C on receipt.
Primer Mix frlmetrs to amplify human DNA 2-8°C after first use, up to the
argets. expiration date stated on the kit.
Iden.tifiler“" Direct Contains amplified alleles. 1 x50.0 yL Store protected from light.
Allelic Ladder See “Allelic ladder profile” on
page 11.
GeneScan™ 600 Contains 36 single-stranded labeled 2 x 200 pL 2-8°C, protected from light.
LIZ™ Size Standard | fragments of: 20, 40, 60, 80, 100, (~800 reactions) Do not freeze
v2.0 114, 120, 140, 160, 180, 200, 214, '

220, 240, 250, 260, 280, 300, 314,
320, 340, 360, 380, 400, 414, 420,
440, 460, 480, 500, 514, 520, 540,
560, 580, and 600 nucleotides.

[ See packaging for expiration date. Do not use expired product.

[l DNA Control 9947A is included at a concentration that is appropriate for use as an amplification control (that is, to provide confirmation of
the capability of the kit reagents to generate a profile of expected genotype). It is not designed for use as a DNA quantification control. If you
quantify aliquots of Control 9947A, the concentration may differ from the labeled concentration.

Required materials not supplied

See Appendix B, “Materials required but not supplied”.
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Instrument and software compatibility

Instrument and software compatibility

Note: Compatible instruments and software that have been discontinued are not listed in this user
guide.

Thermal cyclers
* \VeritiPro™ Thermal Cycler, 96-well
* ProFlex™ 96-well PCR System
* ProFlex™ 2 x 96-well PCR System
* ProFlex™ 3 x 32-Well PCR System

Genetic analyzers and data collection software

Genetic analyzer Data collection software
SeqStudio™ Flex Series Genetic Analyzer SeqStudio™ Flex Series Instrument Software v1.0, v1.0.2, or
vi.1.1
SegStudio™ Genetic Analyzer SegStudio™ Data Collection Software v1.2.4

SegStudio™ Data Collection Software v1.2.1

SeqgStudio™ Data Collection Software v1.2

3500/3500xL Genetic Analyzer 3500 Series Data Collection Software v3.3 (Windows™ 10
operating system)

3500 Series Data Collection Software v 3.1 (Windows™ 7
operating system)

3730/3730x/ DNA Analyzer ® 3730x/ Data Collection Software 5 (Windows™ 10
operating system)

e 3730/3730x/ Data Collection Software 4.1
(Windows™ 10 operating system)

Note: We recommend the 48-capillary
array for the 3730x/ instrument. The
close proximity of capillaries in the 96-
capillary array can introduce cross-talk
between capillaries and interfere with data 3730/3730x/ Data Collection Software 4.0 (Windows™ 7
interpretation. operating system)

Analysis software
* Microsatellite Analysis Software (accessible from apps.thermofisher.com)
* GeneMapper™ Software v6 Software (Windows™ 10 operating system)
* GeneMapper™ Software v5 Software (Windows™ 7 operating system)

For more information
* For testing information on specific platforms, see the instrument or software user documentation.

* For ordering information, see Appendix B, “Materials required but not supplied”.

CLA Identifiler™ Plus and Identifiler™ Direct PCR Amplification Kits User Guide 15
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Workflow

Workflow

CLA Identifiler™ Plus and Identifiler™ Direct PCR Amplification Kits

Perform PCR

* If you are analyzing a cell suspension, see Chapter 2, “Perform PCR: CLA Identifiler™ Plus kit”

* [f you are spotting a cell suspension on a NUCLEIC-CARD™ matrix, see Chapter 3, “Perform
PCR: CLA Identifiler™ Direct kit”

Perform electrophoresis
1. “(Before first use of the kit) Set up the capillary electrophoresis instrument” on page 28

2. “Prepare samples for electrophoresis and start the run” on page 32

Analyze data

e Chapter 5, “Analyze data with Microsatellite Analysis Software”
® Chapter 6, “Analyze data with GeneMapper™ Software”
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Guidelines for cell line preparation, extraction, and
purification

Follow your standard laboratory operating protocol and consider the following guidelines:

The required DNA input amount is 1 ng of genomic DNA extracted from cells.

If a cell line is to be used for research and the identity is unknown, expand the cell line before use.
Follow cell culture best practices.

Handle cell lines under quarantine conditions if the cell line identity is unknown.

One T-25 flask (for attached cells) or a 125 mL Erlenmeyer (for suspension) provides enough
material for DNA extraction.

Obtain cells at an early passage.

Continue growing cells while STR analysis is performed. Consider quarantine until the STR
identification is available. After obtaining the STR identification, proceed with preparing freeze
stocks or continued use of the cells for additional experiments.

Clean the work surface area thoroughly.

Prepare samples one at a time.

Clearly label samples with cell line information.

Extract, purify, and quantify the DNA, see www.thermofisher.com/gdnaprep.

CLA Identifiler™ Plus and Identifiler™ Direct PCR Amplification Kits User Guide 17
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Effect of DNA quantity on results

Effect of DNA quantity on results

The required DNA input amount is 1.0 ng for 29-cycle PCR or 500 pg for 30-cycle PCR.

If too much DNA is added to the PCR reaction, the increased amount of PCR product that is generated
can result in the following:

* Fluorescence intensity that exceeds the linear dynamic range for detection by the capillary
electrophoresis instrument (“off-scale” data). Off-scale data are a problem because:

— Quantification (peak height and area) for off-scale peaks is not accurate. For example, an allele
peak that is off-scale can cause a corresponding stutter peak to appear higher in relative
intensity, therefore increasing the calculated percent stutter.

— Multicomponent analysis of off-scale data is not accurate. This inaccuracy results in poor
spectral separation (“pull-up”).

* Incomplete +A nucleotide addition.
To address these problems, rerun the amplification reaction using less DNA.

If too little DNA is added to the PCR reaction, the total number of allele copies added to the

PCR reaction could be extremely low. Unbalanced amplification of the alleles can occur because of
stochastic fluctuation.

Before you begin

(Optional) Prepare low-TE buffer

For optimal results, we recommend using low-TE buffer for sample preparation. Prepare the low-TE
buffer as described in this procedure or purchase TE Buffer (Cat. No. 12090015).
1. Mix the buffer components together.
e 10 mL of 1 M Tris-HCI, pH 8.0
e 0.2mL of 0.5 M EDTA, pH 8.0
* 990 mL glass-distilled or deionized water

Note: Adjust the volumes proportionally for specific needs.

2. Aliquot, then autoclave the solutions.

3. Store the aliquots at room temperature.

(Before first use of the kit) Thaw reagents

Thaw the master mix and primer mix.

IMPORTANT! The fluorescent dyes attached to the primers are light-sensitive. Protect the primer mix,
amplified DNA, allelic ladder, and size standard from light when not in use.

IMPORTANT! Thawing is required only before first use of the kit. After first use, the reagents are stored
at 2-8°C and do not require subsequent thawing. Do not refreeze the reagents.
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Number of PCR cycles to use

Number of PCR cycles to use

All kits are optimized for a specific number of amplification cycles to deliver well-balanced and high
quality results. However, increases in the number of low-level DNA samples being submitted for
analysis have prompted many laboratories to evaluate a higher number of amplification cycles to
improve the sensitivity of the assay. Before increasing the cycle number, perform a comprehensive
validation study to establish new performance criteria for the higher cycle number.

Higher cycle numbers can cause the following to occur:

Exaggerated stochastic effects resulting from low DNA input amounts
Greater difference between the presence and absence of an allele
Greater heterozygote peak imbalance

Possible differences in expected stutter position and percentage

Possible increase in artifacts and/or background in the profile to accompany the increase in sample
allele signal

The Identifiler™ Plus kit offers two PCR-cycle-number options:

Standard 28-PCR-cycle protocol—Provides high sensitivity to consistently generate full STR
profiles with 125 pg of DNA input. Use with the optimum 1.0 ng DNA input amount in a maximum
input volume of 10 pL.

29-PCR-cycle protocol—Adds the extra sensitivity when amplifying <125 pg DNA input.
Recommended for use when the total DNA input amount is <0.5 ng.

Prepare the amplification kit reactions

IMPORTANT! The fluorescent dyes attached to the primers are light-sensitive. Protect the primer mix,
amplified DNA, allelic ladder, and size standard from light when not in use.

1.

3.

4.

Vortex the master mix and primer mix for 3 seconds. Before opening the tubes or bottles, remove
droplets from the caps by briefly centrifuging the tubes or tapping the bottles on the bench.

Pipet the required volumes of reaction mix components into an appropriately-sized, clear (non-
colored), polypropylene tube.

Component Amount per reaction
Master mix 10.0 yL
Primer mix 5.0 L

Note: Include volume for additional reactions to provide excess volume for the loss that occurs
during reagent transfers.

Vortex the reaction mix for 3 seconds, then briefly centrifuge.

Pipet 15 pL of the reaction mix into each well of a MicroAmp™ Optical 96-Well Reaction Plate or
each MicroAmp™ tube.
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Perform PCR

5. (If needed) Adjust the sample input amount and volume.

¢ If the total sample input amount is >1.0 ng for 28 cycles or >500 pg for 29 cycles, dilute with
low-TE buffer to achieve a 10-uL input volume.

* |f the total input volume is <10 L, adjust the volume with low-TE buffer to achieve a
10-pL input volume.

6. Prepare the samples and controls as shown in the following table, then add to the appropriate
wells or tubes. The final reaction volume is 25 pL.

Amount per reaction
Component
28-cycle protocol 29-cycle protocol
Negative control 10 pL of low-TE buffer 10 pL of low-TE buffer
Test sample 10 pL of DNA (1.0 ng input amount) 10 pL of DNA (0.5 ng input amount)
Positive control 10 pL of control DNA (0.1 ng/pL) 10 pL of control DNA (0.1 ng/uL)

7. Seal the plate with MicroAmp™ Clear Adhesive Film or MicroAmp™ Optical Adhesive Film, or cap
the tubes.

IMPORTANT! We recommend adhesive film for plate sealing to provide a consistent seal across
all wells and prevent evaporation. Do not use caps for the plate, which may not provide a
consistent seal across all wells.

8. Centrifuge the tubes or plate at 3,000 rpm for 20 seconds in a tabletop centrifuge (with plate
holders, if using 96-well plates).

Proceed to “Perform PCR” on page 20.

Perform PCR

IMPORTANT! The kit is optimized for use with the thermal cyclers that are listed in “Instrument and
software compatibility” on page 15.

1. Program the thermal cycler.
a. Set the ramping mode to 9700 Simulation.

b. Set the thermal cycling conditions as shown in the following table.

Cycle (28 or 29 cycles)!!]
Initial incubation step Final extension Final hold
Denature Anneal/Extend
HOLD CYCLE HOLD HOLD
95°C, 11 minutes 94°C, 20 seconds | 59°C, 3 minutes | 60°C, 10 minutes | 4°C, up to 24 hoursl?!

' See “Number of PCR cycles to use” on page 19.
@' The infinity (c0) setting allows an unlimited hold time.
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0
Perform PCR

2. Load the plate or tubes into the thermal cycler, close the heated cover, then start the run.

3. When the run is complete, store the amplified DNA.

Storage time Temperature
<2 weeks 2-8°C
>2 weeks —-25°C to -15°C

IMPORTANT! Protect the amplified DNA from light.
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Guidelines for cell line preparation, extraction, and
purification

Follow your standard laboratory operating protocol and consider the following guidelines:

* Prepare the cell line samples with an optimal target cell density of 1 x 106 cells/mL

22

- For cell density >1 x 108 cells/ mL, dilute with a volume of phosphate buffered saline (PBS) that
yields a cell density of 1 x 106.

- For cell density <1 x 108 cells/ mL, re-centrifuge, then resuspend in a volume of PBS that
yields a cell density of 1 x 108.

If a cell line is to be used for research and the identity is unknown, expand the cell line before use.
Follow cell culture best practices.
Handle cell lines under quarantine conditions if the cell line identity is unknown.

One T-25 flask (for attached cells) or a 125 mL Erlenmeyer (for suspension) provides enough
material for spotting on NUCLEIC-CARD™ matrix.

Obtain cells at an early passage.

Continue growing cells while STR analysis is performed. Consider quarantine until the STR
identification is available. After obtaining the STR identification, proceed with preparing freeze
stocks or continued use of the cells for additional experiments.

Clean the work surface area thoroughly.
Prepare samples one at a time.
Clearly label samples with cell line information.
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Prepare the NUCLEIC-CARD™ matrix with sample \

Prepare the NUCLEIC-CARD™ matrix with sample

Note: The allelic ladder is not a sample. Do not include it in PCR.

1. Spot 40 pL of the cell suspension in the center of the matrix.

\®
—®

Cell ID
Passage
Date

 —

QOSSN 1117 —
@ Matrix

@ 40 pL of the cell suspension spotted in center of matrix

2. Place the spotted card in a laminar flow hood and allow to dry at room temperature for 24 hours.

3. Obtain the punch: Place the tip of a 1.2 mm puncher in the center of the card, hold the barrel of
the puncher (do not touch the plunger), gently press and twist 1/4-turn, then eject the disc in to the
appropriate well on the reaction plate.

Note: Do not add water to the wells on the reaction plate before adding the discs. If you observe
static issues with the paper discs, you can prepare and dispense the 25-pL reaction mix into the
wells of the reaction plate before adding the punches.
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Before you begin

Cell ID

Passage
Date

 —

LIS 171 e

@ Obtain the punch from the center of the sample spotted on the matrix

@ Clean the puncher for the next sample by obtaining a punch from a clean area of the matrix away from the
spotted sample

4. Clean the puncher for the next sample by obtaining a punch from a clean area of the matrix away
from the spotted sample. Discard the punch.

5. (Optional) To store the spotted NUCLEIC-CARD™, place it in a paper envelope with a desiccant
packet. Spotted cards can be stored at room temperature for up to 20 years.

Before you begin

(Before first use of the kit) Thaw reagents

Thaw the master mix and primer mix.

IMPORTANT! The fluorescent dyes attached to the primers are light-sensitive. Protect the primer mix,
amplified DNA, allelic ladder, and size standard from light when not in use.

IMPORTANT! Thawing is required only before first use of the kit. After first use, the reagents are stored
at 2-8°C and do not require subsequent thawing. Do not refreeze the reagents.
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Prepare the amplification kit reactions

Prepare the amplification kit reactions

IMPORTANT! The fluorescent dyes attached to the primers are light-sensitive. Protect the primer mix,
amplified DNA, allelic ladder, and size standard from light when not in use.

1.

7.

Add samples and controls to the appropriate wells of a reaction plate.

Component Amount per reaction
Negative control 1.2 mm blank disc
Test sample 1.2 mm sample disc
Positive control 2 pL of Control DNA 9947A
IMPORTANT! Do not add a blank disc to the positive control well.

Note: The volumes of positive control are suggested amounts and may be adjusted if peak
heights are too high or too low for your optimized cycle number.

Vortex the master mix and primer mix for 3 seconds. Before opening the tubes or bottles, remove
droplets from the caps by briefly centrifuging the tubes or tapping the bottles on the bench.

Pipet the required volumes of reaction mix components into an appropriately-sized polypropylene
tube.

Component Amount per reaction
Master mix 12.5 yL
Primer mix 12.5puL

Note: Include volume for additional reactions to provide excess volume for the loss that occurs
during reagent transfers.

IMPORTANT! This kit is optimized for a 25-uL PCR volume to overcome the PCR inhibition that is
expected when amplifying unpurified samples. Using a lower PCR reaction volume may reduce the
ability of the kit chemistry to generate full STR profiles.

Vortex the reaction mix for 3 seconds, then briefly centrifuge.
Pipet 25 pL of the reaction mix into each well of a MicroAmp™ Optical 96-Well Reaction Plate.

Seal the plate with MicroAmp™ Clear Adhesive Film or MicroAmp™ Optical Adhesive Film.

IMPORTANT! We recommend adhesive film for plate sealing to provide a consistent seal across
all wells and prevent evaporation. Do not use caps, which may not provide a consistent seal across
all wells.

Centrifuge the plate at 3,000 rpm for 20 seconds in a tabletop centrifuge with plate holders.

Proceed to “Perform PCR” on page 26.
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Perform PCR

Perform PCR

IMPORTANT! The kit is optimized for use with the thermal cyclers that are listed in “Instrument and
software compatibility” on page 15.

1. Program the thermal cycler.
a. Set the ramping mode to 9700 Simulation.

b. Set the thermal cycling conditions as shown in the following table.

Initial 26 cycles . . ,
. . Final extension Final hold
incubation step Denature Anneal Extend
HOLD CYCLE HOLD HOLD
95°C, 94°C, 59°C, 72°C, 60°C, 4°C,
11 minutes 20 seconds 2 minutes 1 minute 25 minutes up to 24 hours!!

1 The infinity (o) setting allows an unlimited hold time.
2. Load the plate into the thermal cycler, close the heated cover, then start the run.

3. When the run is complete, store the amplified DNA.

Storage time Temperature
<2 weeks 2-8°C
>2 weeks -25°C to -15°C

IMPORTANT! Protect the amplified DNA from light.
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B (Before first use of the kit) Set up the capillary electrophoresis instrument ................... 28
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Allelic ladder requirements for electrophoresis

To accurately genotype samples, you must run an allelic ladder with the samples.

Number of allelic ladders | One injection | Number of samples per
Instrument .
to run equals allelic ladder

SegStudio™ 24 Flex Genetic 1 per injection 24 samples 23 samples + 1 allelic

Analyzer ladder

SegStudio™ 8 Flex Genetic 1 per 3 injections 8 samples 23 samples + 1 allelic

Analyzer ladder

SeqgStudio™ Genetic Analyzer 1 per 6 injections 4 samples 23 samples + 1 allelic
ladder

3500xL Genetic Analyzer 1 per injection 24 samples 23 samples + 1 allelic
ladder

3500 Genetic Analyzer 1 per 3 injections 8 samples 28 samples + 1 allelic
ladder

3730 2 per injection 48 samples | 46 samples + 2 allelic
ladders

" We recommend the 48-capillary array for the 3730x/ instrument. The close proximity of capillaries in the 96-capillary array can
introduce cross-talk between capillaries and interfere with data interpretation.

IMPORTANT! Variation in laboratory temperature can cause changes in fragment migration speed
and sizing variation between runs. Follow the guidelines in the preceding table, which should account
for normal variation in run speed. To facilitate accurate genotyping of all samples in your laboratory
environment, perform internal validation studies to verify the required allelic ladder injection frequency.

It is critical to genotype using an allelic ladder that is run under the same conditions as the samples.
Size values obtained for the same sample can differ between instrument platforms because of different
polymer matrices and electrophoretic conditions.
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Materials required for electrophoresis

Materials required for electrophoresis

Appendix B, “Materials required but not supplied” lists the required materials that are not supplied with

the Kkit.

IMPORTANT! The fluorescent dyes attached to the primers are light-sensitive. Protect the primer mix,
amplified DNA, allelic ladder, and size standard from light when not in use.

(Before first use of the kit) Set up the capillary
electrophoresis instrument

Data collection software setup

To analyze PCR products generated by the kit, you can use the data collection software and run
parameters provided in this section. See the appropriate table for your instrument.

Note: For detailed procedures, see the appropriate user documentation for your instrument, as listed in
Appendix D, “Documentation and support”.

Table 3 Software setup: SeqStudio™ Flex Series Genetic Analyzer

SeqStudio™ Flex Data
Collection Software

(Optional) Additional software

Run parameters

v1.0, v1.0.2, or v1.1.1

SAE Administrator Console v2.1

SeqStudio™ Plate Manager
Software v2.1, v2.1.1

SegStudio™ Flex Remote
Monitoring Software

Size standard: GS600LIZ(60-600)

Run module —Factory default run modules:
* FragmentAnalysis36_POP7(xI)
* FragmentAnalysis50_POP7(xI)

Injection protocol:
* Fragment_Protocol_36_POP7(xl)
* Fragment_Protocol_50_POP7(xl)

Injection conditions and run conditions: Per the
factory default run modules

Dye set: G5 (DS-33)

Analysis settings: Fragment_Default

28
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(Before first use of the kit) Set up the capillary electrophoresis instrument

Table 4 Software setup: SeqStudio™ Genetic Analyzer

(7

A

SeqStudio™ Data Collection
Software

(Optional) Additional software Plate setup

v1.1.4 or later ®

SAE Administrator Console v2.0, v2.1

Run module: FragAnalysis

SeqgStudio™ Plate Manager Software v1.2, v2.0
q & Dye set: G5 (DS-33)

Table 5 Software setup: 3500/3500xL Genetic Analyzer

3500 Data

Operating system | ¢, .o ction Software

Run parameters

Windows™ 10 v3.3

Size standard: GS600LIZ(60-600)

Run module —Factory default run modules:
* FragmentAnalysis36_POP7(xI)
* FragmentAnalysis50_POP7(xl)

Injection protocol:
* Fragment_Protocol_36_POP7(xl)
* Fragment_Protocol_50_POP7(xl)

Injection conditions and run conditions: Per the factory default run
modules

Dye set: G5 (DS-33)

Analysis settings: Fragment_Default

Windows™ 7 v3, v3.1

Same conditions as for 3500 Data Collection Software v3.3

Table 6 Software setup for the 3730/3730x/ DNA Analyzer

Operating system 3730/3730x/ Data Collection Software Run parameters
Windows™ 10 * (3730xl only) v5 Run module:
° v4.1

* GeneMapper_36_POP7_1
* GeneMapper_50_POP7_1

Windows™ 7 v4.0

Dye set: G5

Note: We recommend the 48-capillary array for the 3730x/ instrument. The close proximity of
capillaries in the 96-capillary array can introduce cross-talk between capillaries and interfere with data

interpretation.
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Spectral calibration

Ensure that the spectral calibration is current: DS-33 Matrix Standard Kit (Dye Set G5). If the spectral
calibration is not current, see the user documentation for your instrument for instructions on performing
the calibration.

Capillary-to-plate mapping

SeqgStudio™ Flex Series Genetic Analyzer

N 1O o JoX JoX Jox Jo 00O HOO®
g O Jol o o o 1o a I I OI6I0OIoI0)
g 6 JoI JoX JoX Jox O 4 I I @JOJOGIOIO)
4 /O JoI JoX loX IoX 1o > |@® @ @0 (») (2)@ (@
3 /O IoX JoX JOX 16X I6) @ @ @ (0 (10 (19|63 G0) G5
3 /O Jor Jox IoX IoX IO - 1® @ @0 (0 (9|60 @ G®
g O o JoX JoX JoX 1o - |® ® @ @ @)|® @ &)
H.IGP..... H.?.@@@@
| |
@O @ ® o e

Figure 4 SeqStudio™ Flex 96-well plate and strip-tube  rjq 6 5 SeqStudio™ Flex 96-well plate and strip-tube
capillary-to-plate mapping (8 capillary) capillary-to-plate mapping (24 capillary)

@ Injection1,3,5,7,9, 11 (wells A-H) Injection 1 (wells A1-H3)

() Injection 2, 4, 6, 8, 10, 12 (wells A—H) Injection 2 (wells Ad—H6)

Injection 3 (wells A7-H9)
Injection 4 (wells A10-H12)

| JONON
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Capillary-to-plate mapping

SeqStudio™ Genetic Analyzer
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Figure 6 SeqStudio™ capillary-to-plate mapping
() Injection 1 (wells A1-D1)
() Injection 2 (wells E1-H1)
() Injection 3 (wells A2-D2)
() Injection 4 (wells E2-H2)

3500/3500xL Genetic Analyzer
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Figure 7 3500 96-well plate capillary-to-plate mapping (8 capillary)
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Figure 8 3500xL 96-well plate capillary-to-plate mapping (24 capillary)
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3730/3730xI DNA Analyzer
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() Injection 2 (wells A2-H2, Ad—H4, A6-H6, A8-H8, A10-H10, A12-H12)
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Figure 9 3730/3730x/ capillary-to-plate mapping (48-capillary array)

Prepare samples for electrophoresis and start the run

Prepare the samples for electrophoresis immediately before loading.

1.

32

Pipet the required volumes of components into an appropriately-sized polypropylene tube.

Component Amount per reaction
GeneScan™ 600 LIZ™ Size Standard v2.0 0.5puL
Hi-Di™ Formamide 8.5 uL

Note: Include volume for additional samples to provide excess volume for the loss that occurs
during reagent transfers.

IMPORTANT! The volume of size standard indicated in the table is a suggested amount.
Determine the appropriate amount of size standard based on your experiments and results.

Vortex the tube, then briefly centrifuge.

Pipet the required volumes of components into each well of a MicroAmp™ Optical 96-Well
Reaction Plate.

Component Amount per reaction
Formamide/size standard mixture 9 uL
PCR product or allelic ladder 1L

Note: For blank wells, add 10 pL of Hi-Di™ Formamide.

Seal the reaction plate with film, then briefly vortex and centrifuge the plate to ensure that the
contents of each well are mixed and collected at the bottom.

Heat the reaction plate in a thermal cycler at 95°C for 3 minutes.

Immediately place the plate on ice for 3 minutes.
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Prepare samples for electrophoresis and start the run

7. Remove the film, then seal with the appropriate septa.

8. Place the sample tray on the autosampler, then start the electrophoresis run.
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m Overview of Microsatellite Analysis Software . .......... ... it 34
B Allelic ladder requirements for CLAdata analysis . ... 35
B Names and versions of settings files used in thissection .......... ... ... ... .. ... ... ... 35
B Access the Microsatellite Analysis Software and importfiles ........ ... ... ... ... .. . ... 35
B Set up the Microsatellite Analysis Software for analysis (before first use of the kit) ............ 39
B Select settings and analyze samples in the Microsatellite Analysis Software .................. 48
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B Examine low-quality Sizing results . . ... . e 51
B Examine low-quality genotyping results . ... 55
B Exportthe genotypestable . ....... .. e 59
B Verify cell line identity usingthe ATCC database .......... ... ... .o .. 60

This chapter contains brief procedures. For more information on using the software, click @ (Help) in
the top right of any Microsatellite Analysis Software screen.

For information on known artifacts in STR kits, see “Application notes” on page 106.

Overview of Microsatellite Analysis Software

Microsatellite Analysis Software is a microsatellite genotyping module available on the Thermo Fisher™
Connect Platform (thermofisher.com/connect).

This software is used to analyze a mixture of DNA fragments, separated by size. The analysis
provides a profile of the separation, precisely calculates the sizes of the fragments, and determines
the microsatellite alleles present in the sample.

The software allows you to view, edit, analyze, print, and export microsatellite marker data generated
using Applied Biosystems™ genetic analyzers.

Note: You may observe minor differences in results if you analyze the same data in the GeneMapper™
Software.
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Allelic ladder requirements for CLA data analysis

Allelic ladder requirements for CLA data analysis

¢ CLA analysis requires at least one allelic ladder sample per project. Perform the appropriate internal
validation studies before you use multiple allelic ladder samples in a project.
For multiple allelic ladder samples, the software calculates allelic bin offsets by using an average of
all allelic ladders that use the same panel in a project.

* Allelic ladder samples must be labeled as "Allelic Ladder" in the Sample Type column in a project.
Analysis will fail if the Allelic Ladder Sample Type is not specified.

* Injections containing the allelic ladder must be analyzed with the same analysis method and
parameter values that are used for samples to ensure proper allele calling.

* Alleles that are not in the allelic ladders do exist. Off-ladder (OL) alleles can contain full and/or
partial repeat units. An off-ladder allele is an allele that occurs outside the bin window of any
known allelic ladder allele or virtual bin.

Note: If a sample allele peak is called as an off-ladder allele, verify the sample result according to
your laboratory protocol.

Names and versions of settings files used in this section

The names and version numbers of the settings files that are shown in this section may differ from the
names and version numbers that you see when you download or import files.

Access the Microsatellite Analysis Software and import files

Before you begin, save FSA files from an instrument run to your computer, to your Connect account on
thermofisher.com/connect, or to a Dropbox™ account. The FSA files can be analyzed or unanalyzed.

This section uses example data files collected on the SeqStudio™ Genetic Analyzer. Example data files
may be available for download. For information, see “(If needed) Download newer versions of settings
files” on page 41.

1. Go to thermofisher.com/connect.

2. Scroll down to the sign in options, then sign in.

Don’t have an account? m Already have a Connect user ID? Sign in

3. Inthe My Apps list at the top right of the screen, click Microsatellite Analysis.

IMPORTANT! Click the text, do not click the icon.
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m Chapter 5 Analyze data with Microsatellite Analysis Software
T Access the Microsatellite Analysis Software and import files

&3 Upload files Create project (O} Search

My apps View all apps

Recommended apps

MSA

[ ]
Mo

Microsatellite Analysis

CE Fragment Eg
More info

If Microsatellite Analysis is not listed under My Apps, scroll down in the All Apps list.

Recent files View all my files My apps

Dashboard © rbout & Uploadfiles [ Create project Q) Search

W c ecommended apps

T Microsatellite Analysis
- CE Fragment Sizing

M Mare info

Recently used

™) Peak Scanner
CE Fragment Sizing
< Q Mare info

View all my instruments

Filter by ™

4. In the Open Project dialog box, select or create a project, then click OK.

Open project X

Open an app within an analysis project
Use Existing Project

| Create New Project

Type a project name
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Access the Microsatellite Analysis Software and import files

5. In the top right of the Manage Data Files screen, click Import From, select the location of the
files, then select the FSA data files of interest.

© &v

My Computer
Therma Fisher Cloud

Dropbox

6. In the top left of the Manage Data Files screen, click [Z4.

Manage Data Files

Files in the project

Name

A1_A1_Sample_20171103_161303.fsa

B1 B1 Sample 20171103 161304.fsa

The Setup screen is displayed.

CLA Identifiler™ Plus and Identifiler™ Direct PCR Amplification Kits User Guide
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Access the Microsatellite Analysis Software and import files

MSA Setup Results

° Set analysis options then analyze 4 samples ¥ Template Manager Actions v

[+

Size Standard View SaveAs  Panel Edit Save A= Analysis Settings View SaveAs | Summary
4 of 4 samples are prepared Reanalyze Samples

GSE00LIZ - - Microsatellite Default - for analysis

8
m Analysis Summary E Sample Table _

Overall Summary

Analysis Results Sizing Genotyping
Analyzed Unanalyzed Reanalyze Total Pass Suspect Low Quality Total Pass Suspect Low Quality Total
0 0 4 4 Y 0 @0 4 ®0 0 @0 0

®

@_

Results by Sample Type

Sample o
S
@
N Q
Sizing Genotyping b
@
e

Pass Suspect Low Quality Total Pass Suspect Low Quality Total

04 0 o0 4 @0 o ®0 0

@ Analysis options for all samples in the project.

@ Analysis Results lists the total number of samples in the project and the number of samples in each analysis status category.
@ Sizing and genotyping results for all samples in the project.

@ Sizing and genotyping results for all samples in the project, organized by sample type.

38

7. |If this is the first time you are using the software, or if you are unsure if the latest settings are
available in the software, continue to “Set up the Microsatellite Analysis Software for analysis
(before first use of the kit)” on page 39.

If you know that the latest settings are available in the software, skip to page 48.
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Set up the Microsatellite Analysis Software for analysis (before first use of the kit)

Set up the Microsatellite Analysis Software for analysis
(before first use of the kit)

About importing files into the Microsatellite Analysis Software database

!! ,IQ

|~ ]

Before you use Microsatellite Analysis Software to analyze CLA data for the first time, you must import
the latest settings files (see “(If needed) Download newer versions of settings files” on page 41).

IMPORTANT! Settings files are instrument-specific. Ensure that you import files for the instrument that
corresponds to the data you will analyze.

Note: The names and version numbers of the files that are shown in this section may differ from the file
names and version numbers that you see when you download or import files.

If you need help to determine the correct files to use, contact your local field applications scientist or

technical support.

File to import File type | Description See page
Includes all settings required for analysis: size standard,

MSA Settings Template ZIp panels and bins, and analysis method. It also retains the 42

(preferred method) plot and table settings of the project from which it was
exported.

Optional individual files to import if you did not import a template (alternative method)

Panel and bins Defines the markers (loci) that are being interrogated, and

(Created with Microsatellite ZIP | includes bins (location of expected alleles) for each marker. 44

Analysis Software)

Size Standard XML Defines the sizes of the fragments present in the size 46
standard.

Analysis settings XML Defines th-e settings for peak detection, allele calling, and 47
peak quality flags.
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"~ Set up the Microsatellite Analysis Software for analysis (before first use of the kit)

Workflow: Set up Microsatellite Analysis Software

Before you use Microsatellite Analysis Software to analyze data for the first time, you must do the
following:

Set up Microsatellite Analysis Software

- Check settings file versions on your computer
. (If needed) Download newer versions of settings files

Import an MSA settings template (preferred method)

Check settings file versions on your computer

1. Access the Microsatellite Analysis Software as described in “Access the Microsatellite Analysis
Software and import files” on page 35.

2. Click £+ next to Size Standard.

° Set analysis options then analyze 5 samples

Size Standard View Save As Panel Edit Save As Analysis Settings View Save As

GS600LIZ - None - Microsatellite Default -

3. Look for settings with a _CLA suffix and check the version of files.

Select your size standard

Size Standard Name

Example_Size 5'.E|I‘II|E|I'
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Set up the Microsatellite Analysis Software for analysis (before first use of the kit) =~

4. Check the version of files for Panel and Analysis Settings.

Select your panel Select your analysis setting

Panel Mame Settings Nama

Example_Fan Example_Analysis 5E‘tti|‘|

5. Check for newer versions of the files on the website as described in the next procedure.

(If needed) Download newer versions of settings files
1. Go to www.thermofisher.com.
2. In the search field, type CLA Kit, then select the kit of interest.

ThermoFisher .
SCIENTIFIC Search All v CLAKif

Product

CLA IdentiFiler™ Plus PCR Amplification Kit
A44660

CLA IdentiFiler™ Direct PCR Amplification Kit
A44661

CLA GlobalFiler™ PCR Amplification Kit
A44662

CLA IdentiFiler™ Plus PCR Amplification Kit
A47624

3. Select the Documents tab, then scroll down to the Reference Materials section.

Product Overview Recommendations Documents

Reference Materials

Matching identities of iPSCs and donors using Identifiler STR profiling kits
White Paper: Matching identities of iPSCs and donors using CLA Identifiler STR profiling kits

Identifiler Data Analysis File CLA v2

[ O

Example Data Files CLA v1

4. |If this is the first time you are using the Microsatellite Analysis Software, or if a newer version of the
download file is available, click the file name to download the file.
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Set up the Microsatellite Analysis Software for analysis (before first use of the kit)

5. Unzip the file.

The ZIP file contains a separate folder for each instrument type. Each instrument folder contains
a folder with Microsatellite Analysis Software settings and GeneMapper™ Software settings (ignore
this folder). The Microsatellite Analysis Software folder contains:

* MSA_Template_CLA_vX.zip—Contains the settings needed to analyze data in the
Microsatellite Analysis Software. Do not unzip the MSA ZIP file. The ZIP file is a template
that contains size standard, panel and bins and analysis settings.

* MSA_Analysis_Settings_CLA_vX folder—Optional individual settings that are also in the
template. These files are not needed if you import the template.

Import an MSA settings template (preferred method)

An MSA settings template ZIP file is created by exporting a template from the Microsatellite Analysis
Software. For information on exporting a template, click @ .

A settings template ZIP file can include all files required for analysis: size standard, panels and bins, and
analysis method. It also retains the plot and table settings of the project from which it was exported.

If the size standard, panel, and analysis method libraries do not contain CLA settings, or if you
downloaded a new version of the template ZIP file, follow this procedure to import the template ZIP
file into the Microsatellite Analysis Software.

Note: Alternatively, you can import individual settings. See “Import individual settings (alternative

method)” on page 44.

1. Access the Microsatellite Analysis Software as described in “Access the Microsatellite Analysis
Software and import files” on page 35.

2. At the top right of the screen, click Template Manager.

@ Setup

Results

° Set analysis options then analyze 5 samples

¥ Template Manager () Analyze  Actions v

3. In the Template Manager dialog box, click Import.

Template Manager X

Select your template

Template Name

=)

Size Standard

Auto analyze [ Export

Modified On v Delete

42
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5. Navigate to, then select the ZIP file for your instrument that you previously downloaded (see “(If
needed) Download newer versions of settings files” on page 41), then click Open.

Chapter 5 Analyze data with Microsatellite Analysis Software @
Set up the Microsatellite Analysis Software for analysis (before first use of the kit) =

In the Import Template dialog box, enter a name for the template (include a "CLA_vX suffix), click

My Computer, then click Import.

Import Template X

Name

Comments

Import From

O &

My Computer Thermo Fisher Cloud

Cancel

The ZIP file is listed in the Template Manager.

6. Click Apply.

The settings are applied to the project.

° Set analysis options then analyze 5 samples

Size Standard Edit SaveAs  Panel

Example Size Standard CLA_vX

Edit Save As

- Example Panel CLA_vX h

e

Analysis Settings Edit Save As

Example Analysis Settings CLA vX ~
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: Set up the Microsatellite Analysis Software for analysis (before first use of the kit)

Import individual settings (alternative method)

If you did not import an MSA settings template, or if you want to update specific settings only, you can
import individual settings.

Import an MSA panel (ZIP file created in the Microsatellite Analysis Software)

Note: This step is not required if you imported an MSA settings template.

A panel ZIP file is created by exporting a panel from the Microsatellite Analysis Software. For
information on exporting a panel, click @.

If your computer already contains the correct size standard and analysis method, and you only need to
import panel and bins, follow this procedure to import the panel and bins.

1. Access the Microsatellite Analysis Software as described in “Access the Microsatellite Analysis
Software and import files” on page 35.

2. Click £¢ in the Panel pane.

Panel Edit Save As

Mone -

3. Click Import in the Panel Manager.

anel {Import Pane]
Jisplay currently

There Is to display cu

4. Click Microsatellites in the Import Panel dialog box.

Import Panel X

GeneMapper { Microsatellites

Import panel (marker) and bin file (.zip)

O &

My Computer Thermo Fisher Cloud

5. Click the import location, then select the panel ZIP file.

6. Click Open, then click Import.

7. Navigate to, then select the ZIP file that you previously downloaded (see “(If needed) Download
newer versions of settings files” on page 41), then click Open.
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Set up the Microsatellite Analysis Software for analysis (before first use of the kit) "

8. Enter a panel name, then click Next.

Note: If a character limit warning is displayed, delete all characters starting with the first
parenthesis in the name. For example if the name is "GF_3500_MSA_Panel_CLA_v1 (GF_3500_v2)
Imported", delete "(GF_3500_v2) Imported".

The Panel Manager displays the panels and associated bins.

Panal Mame * Markers + Bins

B 018551 2 G Q ' Actions. v Markers Bin Details Reference Data
B 0 A a1 lz= s B | +) Agd Mase ] Delets o
Mo Own L] P Raxpaaf Shrtier

ANEL [ | 106.00 400 @ ]
C13ENT u 20EE5 2501E 4 il o]
[] N
TR | 699 2600k 4 Dos3a
=2 | | 206I5 JGDe 4 0.733
DESERD | 25530 MnE 4 0103
L i it e s s sttt Das1I5E - sE0 e 4 noazIT
DnEss DTS [ | SS100 RS 4 0000
Al kg W0 Mashap' Rangecs. (88 - 3711
1 ______________§ 8§ | c21EN L] 18450 24750 4 D.DET
| ! . ¥
. £ £ | DES11TR [ | 1880 RS0 4 iRl .
.| | . .

=R eu

IMPORTANT! If the left pane does not show gray bins, click Import Bins at the bottom left of the screen, then
import the associated bin file.

9. Click Save, then click Back to Library.

10. Click Apply to select the panel for the project.
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4 Set up the Microsatellite Analysis Software for analysis (before first use of the kit)

Import a CLA size standard (XML files provided by Thermo Fisher Scientific)

Note: This step is not required if you imported an MSA settings template.

1. Access the Microsatellite Analysis Software as described in “Access the Microsatellite Analysis
Software and import files” on page 35.

2. Click £* in the Size Standard pane. @
Size Standard View Save As
3. Click Import in the Size Standard library.
GS600LIZ -
Select your size standard Auto analyze  [® Export ™, Clone
Size Standard Name Description # Peaks Created On Modified On v Details Delete

& GS1200L1Z Factory Provided 68 11-Aug-2008 07:39 ... 11-Aug-2008 07:39 ... View -

B Factory Provided 27-Jun-2008 02:03 PM  27-Jun-2008 02:03 PM

& GS600LIZ Normalization Factory Provided 36 27-Jun-2008 01:59 PM  27-Jun-2008 01:59 PM View

& . GS500(-35,-250,-340)R0OX Factory Provided 13 11-Jun-2008 08:04 PM  11-Jun-2008 08:04 PM View

& GS500(-35,-250,-340)LIZ Factory Provided 13 17-Apr-2008 05:58 PM  17-Apr-2008 05:59 PM View

& . GS500ROX Factory Provided 16 17-Apr-2008 05:58 PM  17-Apr-2008 05:58 PM View

& . GS500(-250)ROX Factory Provided 15 17-Apr-2008 05:56 PM  17-Apr-2008 05:56 PM View

& SNPlex_48plex_v1 Factory Provided 11 26-Sep-2003 02:16 ... 26-Sep-2003 02:16 ... View -

o [ o]
4. Inthe Import Size Standard dialog box, click the

location of the files, then click Import.

[a)
5. Navigate to and select the size standard XML file, then ? I
click Open.
=n
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6. In the Import Size Standard dialog box, edit the size standard information if needed, then click
Save.

Import Size Standard

Size Standard Name and Dye Caolor

¥  Example_LS_Size Standard_CLA vX

Description (optional)

Local Southern Sizing 80-460

Number of Peaks: 26

60.00, 80.00, 100.00, 114,00, 120.00, 140.00, 160.00, 180.00, 200.00, 214.00,
220.00, 240.00, 250.00, 260.00, 280.00, 300.00, 314.00, 320.00, 340.00, 3560.00,
380.00, 400,00, 414.00, 420.00, 440.00, 460.00

N

Note: If a character limit warning is displayed, delete all characters starting with the first
parenthesis in the name. For example if the name is "GF_MSA_SizeStd_CLA_v1 (GF_3500_v2)
Imported", delete "(GF_3500_v2) Imported".

The size standard is added to the Size Standard library.

7. Inthe Size Standard library, click Apply to select the size standard for the project.

Import a CLA analysis settings (XML file provided by Thermo Fisher Scientific)

Note: This step is not required if you imported an MSA settings template.

1. Access the Microsatellite Analysis Software as described in “Access the Microsatellite Analysis
Software and import files” on page 35.

2. Click #¢ in the Analysis Settings pane. @
Analysis Settings View Save As

Microsatellite Default -
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3. Click Import in the Analysis Settings library.

Analysis Settings X

Select your analysis setting Auto analyze  [# Export ™% Clone

Settings Name Created On Modified On » Dietails Delete

@ Microsatelliite Default 26-Apr-2018 06:37 AM  26-Apr-2018 0637 AM

=N =n
4. In the Import Analysis Settings dialog box, click the

location of the files, then click Import.

Import From

5. Navigate to and select the analysis settings XML file for e &
your instrument, then click Open. S

6. Click Save. =

Note: If a character limit warning is displayed, delete all characters starting with the first
parenthesis in the name. For example if the name is "GF_3500_MSA_AM_CLA_v1 (GF_3500_v2)
Imported”, delete "(GF_3500_v2) Imported".

The analysis settings file is added to the Analysis Settings library.

7. In the Analysis Settings library, click Apply to select the analysis settings for the project.

Plot and table settings

Plot and table settings are not stored in separate files that you can import and export. However, the
current plot and table settings are retained when you export a template from the Microsatellite Analysis
Software. For information on exporting a template, click @.

Select settings and analyze samples in the Microsatellite
Analysis Software

1. If CLA settings are not selected, click £ for Size Standard, Panel, and Analysis Settings, then
select the appropriate CLA size standard, CLA panel, and CLA analysis settings.

Lt Lt

Size Standard cait Save s Panel  Edit Save As Analysis Settings view Save As

GSe0-600LIZ - Mona - Microsatellite Default -
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Select settings and analyze samples in the Microsatellite Analysis Software |

IMPORTANT! Analysis settings are instrument-dependent. Size standard may also be instrument-
dependent. Select an analysis settings file that corresponds to the instrument on which the
imported data was collected.

2. Click the Sample Table tab.

3
Size Standard Edit SaveAs Pa

Example Size Standard  CLA wvX ™ |

M Analysis Summary [ 8 Sample Table

@ Setup Results

° Set analysis options then analyze 5 samples

£ & ]

LTemp\ate Manager () Reanalyze Actions v

Size Standard Edit Savehs  Panel Edit Savens  Analysis Settings Edit Savess  Summary
0 of 5 samples ars prepared for Reanalyze Samples
Example Size Standard CLA_VX ¥ Example Panel CLA_vX - Example Analysis Settings CLA_vX * analysis

J Status sQ GQ.. Sample File Name Sample Name Sample Type Instrument Model Plata Id Wall Size Standard Panel REF sal
=] [ ] C1_PosCtrl fsa 9947A #  Positive Control #  SeqStudio-3200  96-Wel cot GS600LIZ
=) [ ] D1_NegCtrl fsa Negative Contre#f  Negative Control #* 96-Wel Dot GS5600LIZ
a [ ] Bi_Sample_02.fsa MaAd # Sample rd 96-We BO1 GS600LIZ
=) [ ] Al_Sample_01fsa Hela #  Sample * 96-Wel A1 GS5600LIZ
= . E1_Ladderfsa Allelic Ladder #  Allelic Ladder o+ 96-Wef EO1 GS600LIZ

In the figure on the previous page, the SQ result for the samples is @ because the samples are
automatically analyzed with the size standard from the data collection software.

Note: For more information about the columns in the sample table, click @.

3. If needed, click a Sample Type field, then select the sample type for the sample.
At least 1 allelic ladder sample type is required.

4. Select the checkboxes for the samples to analyze. You can click the checkbox in the header to
select all samples.
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" Review the analysis summary

5. Click Reanalyze Samples.

m Analysis Summary ‘ @ Sample Table

¥ Status SQ GQ a  Sample Name Sample Type Instrument Model Well  Size Standard Panel 0s
Negative Control #  Negative Control I'd Example Size Std Example Panel
Positive Control 4 Example Size Std Example Panel
Example Size Std Example Panel
Example Size Std Example Panel

Allelic Ladder #  Allelic Ladder rd Example Size Std Example Panel

Review the analysis summary
1. Click the Analysis Summary tab.

o3
Size Standard Edit Save As P

Example Size Standard_ CLA_ vX ~

m Analysis Summary E Sample Table

Note: For more information about the columns in the sample table, click @.
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N

Examine low-quality sizing results

Bl

Overall Summary

Analysis Results Sizing

Genotyping

Analyzed Unanalyzed Reanalyze Total Pass Suspect Low Quality Total Pass Suspect Low Quality Total
5 o 0 5 85 0 [ 1] 5 LY o s 5
©,
Results by Sample Type
Allelic Ladder
@_ Sizing Genctyping
Pass Suspect Low Quality Total Pass Suspect Low Quality Total
o1 [ ®0 1 ®0 0 [ B 1
Sample
Sizing Genotyping
Pass Suspect Low Quality Total Pass Suspect Low Quality Total
04 a ®0 4 @0 0 ®: 4
@ Sizing and genotyping results for all samples in the project.
@ Sizing and genotyping results for all samples in the project, organized by sample type.
2. Click the number next to any @, « , or @ indicator to display the results for the sample or allelic

ladder.

Examine low-quality sizing results

Before proceeding, ensure that you have selected the correct size standard and analysis method (which

may be instrument-specific) for the data you are analyzing.

View data collection settings

1. In the Setup screen, open the Sample Details window using one of the following methods:

¢ Right-click on the sample file in the Sample Table, then click View Sample Details.

¢ Click Actions » View Sample Details.

2. Click Information to review the data collection settings.

3. Click Close.
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Examine EPT and raw data

Review the EPT (ElectroPherogram Telemetry) plot to identify instrument performance issues that can
affect size quality.

Review the raw data to evaluate anomalies, the causes of poor size-calling, and to determine the start
and stop points for analysis. The start point for data analysis occurs after the primer peak and before
the first sizing peak. The stop point for analysis occurs after the last sizing peak.

1. Open the sample details window using one of the following methods:

* Right-click on the sample file in the Sample Table, then click View Sample Details.
* (Click Actions » View Sample Details.

2. Click EPT to view the EPT plot.
3. Click Raw Data to view the raw data plot.

4. Click Close.

Review size matches
1. In the Setup screen, click the Analysis summary tab.

2. In the Sizing analysis results pane, click on the blue number next to  or @ to review size
matches for these samples in the Size Matching tab of the Results screen.

Genotyping
Pass Suspect Low Quality Total

2 2 [ 5

v_

3. Modify the size matches as needed.

Modify size matches

If the software does not correctly detect size standard peaks, you can modify the size matches, then
apply the modified size standard definition to all selected samples in the project.

1. Select an option to view the peak assignments for the size standard peaks in the selected sample:

Option Action

View in Size 1. In the Results screen, click the Size Matching tab.

Matching tab . . ) ) o
2. Select a sample from the sample list to view the peak assignments in the Sizing

Match pane at the bottom of the screen.

View in Size 1. In the Results screen, click the Sizing tab.

Match Editor .
2. Select one or more samples from the sample list.

3. Click Actions » View Size Match Editor.
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Examine low-quality sizing results

Sizing Match Size Calling Curve

M oY @, Q, m, Override SQ v L
Size Quality (SQ) = 1.0
36 Size Peak
e Peaks 1000 2000 3000 4000 5000 6000 7000 3000 3000 10000

¥ BP 112 -

4000+ . .
18 160 - 100 - 280300 3

3500 6 B 14 | 28
19 Leo 360

3000 . . ate 4a

314 o 460, T4

20 180 2500+ iz

2000+ s
21

15001 - o
22 200 508y

10004
23 5004

0

24 214 =

Reanalyze all files with this size standard

Export size standard {.xml)

2. Examine all size standard peaks to ensure that all peaks are present, peaks are labeled correcily,
and the sizes match the fragment sizes in the size standard definition file that is used for the

sample.

3. Change size values or delete peaks as needed, then auto-adjust size matches. This function is
useful if the software incorrectly labels a peak.

Task Action
Qhange a 1. Click the size value in the list, or click a peak or peak size label in the plot, then
size value select a different value from the dropdown list.
2. Select the same peak, then click E (auto adjust).
For example, changing the 110 peak to 100, then clicking E sequentially shifts the 110
size label to the current 100 peak, the 120 size label to the current 110 peak, and so on.
Delete a 1. Click the size value in the list, or click a peak or peak size label in the plot, then
peak select Delete in the dropdown list.
2. Select the same peak, then click | & |.
For example, deleting the 110 peak, then clicking E sequentially shifts the 110 size
label to the current 120 peak, the 120 size label to the current 130 peak, and so on.

4. Click [ v |to recalculate the SQ using the new sizes.

5. Click Override SQ.
The SQI (Sizing Quality Invalid) indicator is displayed:

In the top right of the Results screen, in the Sizing tab, any sample that is analyzed with the

size standard—Displays SQl: Y.

Note: If SQI does not display in the Sizing tab, click @, then search for Customize the plot

view.

* In the Setup screen Sample Table —Displays in the SQI field.

CLA Identifiler™ Plus and Identifiler™ Direct PCR Amplification Kits User Guide 53



PSR Chapter 5 Analyze data with Microsatellite Analysis Software
Examine low-quality sizing results

6. (Optional) To create a new size standard definition for the project using the modified size matches,
click Reanalyze all files with this size standard.

7. Click Done.

Modify the analysis settings

For a description of analysis settings, click @, then search for Analysis Settings.

1. In the Setup screen, in the Analysis Settings pane, click £t.

2. Select the analysis setting from the list, then select Edit.
The following settings are recommended for CLA data analysis. Modify other settings as needed.

CLA Identifiler™ Plus kit and CLA Identifiler™ Direct kit
Analysis parameter
SeqStudio™ Flex, SeqStudio™, 3500 3730
Baseline Window Size 51 (default) 51 (default)
Peak Window Size 15 (default) 11
Smoothing Light (default) Light (default)
Size Calling Local Southern (60-460) Local Southern (60-460)

3. Select Auto analyze, then click Apply.

Adjust Size Quality Flag ranges
1. In the Setup screen, in the Analysis Settings pane, click £t.
2. Select an analysis setting, then click Edit.
3. Click the Sizing Settings tab.

4. Click Quality Flags.
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5. Adjust the low, medium and high ranges as appropriate.

— Quality Flags

Size Quality Status

Set the pass/fail status of the size standard. If samples fall

in the low quality range, peaks will not be sized. If samples fall
in the medium or high quality range, peaks will be sized.

Low Medium High
0 —. ._ 1
0.25 0.75

5

Figure 10 Quality Flag ranges
@ Drag to adjust the quality flag ranges.

6. Click Save, select the Auto analyze checkbox, then click Apply.

Examine low-quality genotyping results

Before proceeding, ensure that you have selected the correct panel and analysis method (which may be
instrument-specific) for the data you are analyzing.

About PQVs (Process Quality Value symbols @ o)
PQVs are flags that reflect the quality of results. ¢ @ are displayed for GQ (genotyping quality) if
any peak in the sample does not meet expected thresholds. is displayed for individual PQVs in the
genotypes table.
Thresholds are set in the Peak Quality and Quality flags tabs in the analysis method.
For definitions of PQVs, click @, then search for Genotyping Quality (GQ) status and Process
Quality Values (PQVs).

Review samples with Suspect and Low Quality GQ values

1. In the Setup screen, click the Analysis summary tab.

2. In the Genotyping analysis results pane, click on the blue number next to ¢ or @ to display the

Genotyping tab of the Results screen.

Genotyping
Pass Suspect Low Quality Total

2 2 [ 5

' \f
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@ Setup Results

- o
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@ Genotypes plot
(@ Genotypes table

Note: You may have to scroll down to view the genotypes table.
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Examine low-quality genotyping results

3. Examine the plots for yellow or red marker headers, which indicate that one or more PQVs have
been triggered. You can double-click on a marker header to zoom on the marker range.

68811?9 D21511 3_?8820 CSF1PO @
100 1

0 50 50 200 250 300 350
80004
40004 ] J l u
0 LA L A _ sl PRUBY (IBY ARIVIRE i

al: 12 al- 27
sz 140,78 sZ: 19575 @
ht: 13941 ht: 11988
al 13 alk 28
sz 144 84 sz: 199.75
ht: 6801 ht: 5876

CW_A1_Sample_01_IF_SeqSt_CLA_v1.fsa

D351358 THOT @_DWSESQ D251338 @

0 50 100 150 200 250 300 350
8000 l ||U‘
4000 | | i
ol ML N S .
@ @ al 17
5731384
Nt 15144

@ Yellow marker header
(2) Red marker header

4. Proceed to “Review PQVs of samples with Suspect and Low Quality GQ or PQV values” on
page 57.

Review PQVs of samples with Suspect and Low Quality GQ or PQV values

1. Display the genotypes results screen (see “Review samples with Suspect and Low Quality GQ
values” on page 55).

2. Scroll down to view the genotypes table, then double-click a row with a © @ GQ or PQV result.
The associated marker is selected in the plot.

Note: You may have to scroll to view the selected marker. Double-click the marker header to
zoom.

The following figures are examples of ¢ and @ GQ results:
e Figure 11 shows a @ GQ result that is caused by an off-ladder allele (OL peak label and BIN
PQv).
* Figure 12 shows a ¢ GQ result is caused by a peak height ratio that does not meet the
threshold (PHR PQV).
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Size Matching Plot Settings v
Enter search term X I Typs: Sample GQ: Fail
GO SO Fi... Well# — —_—
- 205 210 215 220 225 230 235 240 245 250
C._.. A1 2000 ] * ) ) % + + + + + +
4000 ! J \
L A
i p L)
- al: 12 al: OL
p D sz: 232.12 sz: 239.27
ht: 3937 ht: 11071

4 »

Total ltems: 1 (Selected ltems: 1)

Gem:llype Table LRV Enter search term b4

Aldlale 1 Allale 2 XLTK PHR
p1osa17 m_m-------mu
D21S11 Blue 27 195.75 199.75 | | | | | | A
D351179 Blus 12 13 140.78 144.84 [ | [ | [ | [ | [ | [ | A NA '
Figure 11 Example 1
@ Double-click a row

@ Associated marker is selected in the plot

Plot Settings v

Type: Sample

GQ: Fail
Sy '@
185 190 195 200 205 210 215 220 225 230 235 240 245 25
8000 ] |
40004
. . - 20 - | v L A
o al: 27
i i
® ® c. Eod e
o 52: 199.75
ht: 5876

1 3

Total ltems: 5 (Selected ltems: 1) —

Genotype Table VRV AN Enter search term X
Markear DyeC... Allele 1 Allele 2 Size 1 Size 2 BIN LPH SPU AN
D1358317 Green i2 oL
D21511

23212

BD XLTK PHR CC GQ
23927 A H H HEH HEH BB A n O
Blue 27 28 195.75 199.75 NA
Figure 12 Example 2
(1) Double-click a row

=

@ Associated marker is selected in the plot

3. As needed, edit alleles. For information, click @, the search for Review, edit, and add alleles
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Export the genotypes table | V|

Export the genotypes table

You can export the genotypes table for reference when you compare the genotypes to the ATCC
database.

1. Open the project that contains the samples of interest.

2. Click the Results tab.

B
° Set analysis options then analyze 5 samples

Size Standard Edit SaveAs Panel

3. Click the Genotyping tab.

Setup Results

- &Ze hhtd.“"g I

4. Scroll down to view the genotypes table, then display the columns that you want to export.

5. Scroll to the top of the screen, then select Actions » Export Genotypes Table.

6. Select the location to save the file, then click Export.

If the web browser is configured to prompt before saving, navigate to the location to save, then
click Save.

If the web browser is not configured to prompt before saving, the file is saved to the Download
folder.
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Verify cell line identity using the ATCC database

Cell line identity can be verified by uploading genotypes to the ATCC cell line STR database. The ATCC
database requires you to enter genotypes for 8 specific loci, all of which are present in the Applied
Biosystems™ CLA STR Kits.

1. In a web browser (for example, Google™ Chrome™), navigate to www.atcc.org/STR_Database.

Note: Click View our brief tutorial before starting if you are not familiar with this website.

2. Click Please log in to search, then log in or create a user profile.

Login | Create a Profile | Quick Order | = (0 items) | USA~| 1.800.638.6597

ATCC | credibleleadstoIncredible™ Search by Keyword or Catalog m

pducts Services Standards Resources Support About

Home » STR Database

WHAT'S IN YOUR

FLASK? SEARCH THE STR DATABASE

lr;:‘isgjlﬁEre”n?ilg:ﬁroen”;akrigg cell As part of our continuing efforts to characterize and authenticate the cell lines in the Cell Biology collection,
recIuisite for pub”caﬁgn and ATCC has developed a comprehensive database of short tandem repeat (STR) DNA profiles for all of our human
funding agencies a requirement cell lines. View our brief tutorial before starting.

for grant support.

Learn more »

1. 3TR Profiling Analysis
2. Matching Algorithm
3. Interrogating the Database

Please log_in to search

3. Refer to the genotypes from the file you exported, then enter the genotypes in the ATCC screen.

4. Click Matches >= 80%.

After a few minutes, a list of cell lines in the ATCC database that match the STRs present in the
test sample is displayed.

Note: The DSMZ at the Leibniz Institute maintains a database of 8-17 STR alleles for common cell
lines. To use the database, see the DSMZ instructions; go to:

https://celldive.dsmz.de/str
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Analyze data with GeneMapper™
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B Allelic ladder requirements for CLAdata analysis . ...t 62
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B Review analyzed results in the sample and genotypestable ........... ... ... ... ... ... 73
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B Display and zoom on sample plots .. ... .. 81
B Display and zoom genotype plots ... ... 83
B Exportthe genotypestable . ....... ... e 85
B Verify cell line identity usingthe ATCC database .......... ... ... o .. 85

This chapter contains brief procedures. For more information on using the software, click @ (Help) or
select the Help menu.

For information on known artifacts in STR kits, see “Application notes” on page 106.

Overview of GeneMapper™ Software

GeneMapper™ Software is a flexible genotyping software package that provides DNA sizing and quality
allele calls for all Applied Biosystems™ electrophoresis-based genotyping systems. GeneMapper™
Software helps increase data processing efficiency with a multiuser, client-server deployment. The
software uses Process Quality Values (PQVs) for automated identification that reduces data review time
for high throughput genotyping. In addition, the security and audit features help users meet 21 CFR 11
requirements.

For information on obtaining the GeneMapper™ Software, contact your local field application specialist.

Note: You may observe minor differences in results if you analyze the same data in the Microsatellite
Analysis Software.
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Allelic ladder requirements for CLA data analysis

* CLA analysis requires at least one allelic ladder sample per run folder. Perform the appropriate
internal validation studies before you use multiple allelic ladder samples in an analysis.
For multiple allelic ladder samples, the GeneMapper™ Software calculates allelic bin offsets by
using an average of all allelic ladders that use the same panel in a run folder.

¢ Allelic ladder samples in an individual run folder are considered to be from a single run. When the
software imports multiple run folders into a project, only the ladders in their respective run folders
are used for calculating allelic bin offsets and subsequent genotyping.

* Allelic ladder samples must be labeled as "Allelic Ladder" in the Sample Type column in a project.
Analysis will fail if the Allelic Ladder Sample Type is not specified.

* Injections containing the allelic ladder must be analyzed with the same analysis method and
parameter values that are used for samples, to ensure proper allele calling.

* Alleles that are not in the allelic ladders do exist. Off-ladder (OL) alleles can contain full and/or
partial repeat units. An off-ladder allele is an allele that occurs outside the bin window of any
known allelic ladder allele or virtual bin.

Note: If a sample allele peak is called as an off-ladder allele, verify the sample result according to
your laboratory protocol.

Names and versions of settings files used in this section

The names and version numbers of the settings files that are shown in this section may differ from the
names and version numbers that you see when you download or import files.
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!‘0‘ \.'I

WA

Set up the GeneMapper™ Software for CLA analysis (before
first use of the kit)

About importing files into the GeneMapper™ Software database

Before you use GeneMapper™ Software to analyze CLA data for the first time, you must import the
latest settings files (see “(If needed) Download newer versions of panel and bin files” on page 65).

IMPORTANT! Settings files are instrument-specific. Ensure that you import files for the instrument that
corresponds to the data you will analyze.

Note: The names and version numbers of the files that are shown in this section may differ from the file
names and version numbers that you see when you download or import files.
If you need help to determine the correct files to use, contact your local field applications scientist or
technical support.

File to import | File type Description See
Defines the markers (loci) that are being interrogated.
Panel TXT IMPORTANT! Use only panel and bin TXT files that are provided by Thermo
Fisher Scientific. If you use panel and bin files that you create in the 66
GeneMapper™ Software, you may see off-ladder alleles.
Bins TXT | Defines bins (location of expected alleles) for each marker.
Analysis Method| XML |Defines the settings used for peak detection, allele calling, and peak quality flags. | 69
Size Standard XML | Defines the sizes of the fragments present in the size standard. 68
Table Settings XML | Hide or show columns, filter results, sort order.
Defines settings for electropherogram plot display including Sample Header 70
Plot Settings XML | Settings, Genotypes Header settings, Sizing Table settings, peak labels settings,
and display settings for Sample and Genotype plots.
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Workflow: Set up GeneMapper™ Software

Set up GeneMapper™ Software

- Check panel and bin file versions on your computer
. (If needed) Download newer versions of panel and bin files
. Import panel and bins

Import analysis method

Import the size standard

Import table settings and plot settings

Check panel and bin file versions on your computer
1. Start the GeneMapper™ Software, then log in with the appropriate user name and password.
2. Select Tools » Panel Manager.

3. Check the version of files that are currently available in the Panel Manager-

a. Select Panel Manager in the navigation pane.
T Panel Manager

b. Expand the Panel Manager folder and any File Edit Bins View
subfolders to identify the analysis file version that Y | 5§ | -
is already installed for your kit choice. - it -

..

L]
i Panel Manager

File Edit Binz Wiew

X | WP H H | M ™ |snset ExampIE_GM_Bin

=) o, Panel Manager Fanel Mame

= (W Identifiler CLA_wX 1 anmple_gM_PaneICLH_vX !

[-|CT)Example_GM_Panel_CLA_wX

i
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Set up the GeneMapper™ Software for CLA analysis (before first use of the kit) T

4. Check the version of files available for import into the Panel Manager:

a. Select Panel Manager, then select File » Import Panels to open the Import Panels dialog
box.

b. Navigate to, then open the Panels folder, then check the version of panel, bin, and stutter files
installed.

5. Check for newer versions of the files on the website as described in the next procedure.

(If needed) Download newer versions of panel and bin files
1. Go to www.thermofisher.com.
2. In the search field, type CLA Kkit, then select the kit of interest.

ThermoFisher ;
SCIENTIFIC Search All v CLAKi{

Product

CLA IdentiFiler™ Plus PCR Amplification Kit
A44660

CLA IdentiFiler™ Direct PCR Amplification Kit
A44661

CLA GlobalFiler™ PCR Amplification Kit
A44662

CLA IdentiFiler™ Plus PCR Amplification Kit
A47624

3. Select the Documents tab, then scroll down to the Reference Materials section.

Product Overview Recommendations Documents

Reference Materials

Matching identities of iPSCs and donors using Identifiler STR profiling kits
White Paper: Matching identities of iPSCs and donors using CLA Identifiler STR profiling kits

Identifiler Data Analysis File CLA v2

[ O P P

Example Data Files CLA v1

4. |If this is the first time you are using the GeneMapper™ Software, or if a newer version of the
download file is available, click the file name to download the file.

5. Unzip the file.
The ZIP file contains a separate folder for each instrument type. Each instrument folder contains a
folder with Microsatellite Analysis Software settings (ignore this folder) and GeneMapper™ Software
settings.
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" Set up the GeneMapper™ Software for CLA analysis (before first use of the kit)

The GeneMapper™ Software folder contains IF_Analysis_Settings_CLA_vX folder, which contains
the settings needed to analyze data in the GeneMapper™ Software.

Import panel and bins

IMPORTANT! Use only panel and bin TXT files that are provided by Thermo Fisher Scientific. If you
use panel and bin files that you create in the GeneMapper™ Software, you may see off-ladder alleles.

1. Start the GeneMapper™ Software, then log in with the appropriate user name and password.

2. Select Tools » Panel Manager.

3. In the left pane, click Panel Manager.
T Panel Manager

Note: If you do not click on Panel Manager, the File Edit Bins View
import commands are not available. s
L X | o N | ']

4. Import the panel file: &-

a. Select File » Import Panels to open the Import
Panels dialog box.

b. Navigate to, then select, the appropriate GM_Panel_CLA_vX.txt you obtained in “(If needed)
Download newer versions of panel and bin files” on page 65.

i Import Panels e

Look in: GeneMapper _Analysis settings w £

o = Example_GM_AM_CLA_vixml
=3 = Example_GM _Bins_CLA vXixt

S0 P B Ecample_GM_Panel CLA_vX.xt

|=| Example_GM_Plot_Set_CLA vt
- |2 Example_GM_SizeStd_CLA vKxml
Desktop =] Example_GM_Table_Set_CLA v it

Ifl File name: Example_GM_Panel _CLA_vX. bt Impaort

Documents  Files of type: | all Files e Cancel
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c. Click Import.

Note: Importing this file creates a new folder in the navigation pane of the Panel Manager.

This folder contains the panel and associated markers.

L]
Lt Panel Manager

File Edit Bins View

w X | W W M | W '™ | binSet: |Example_GM Bins_CLA WX

= g5, Panel Manager Fanel Hame

(Ea® (i Identifler_CLA_wX 1 anmple_EM_Panel_C-L.ﬁ._vX

Import the bins file:
a. Select the Identifiler folder in the navigation pane.

o]
Lt Panel Manager

File Edit Bins View

X | WM M | W ™ | sinSet: Example_GM_Bins_CLA VX

s

= o Panel Manager Fanel Name

[ (W [dentifiler CLA wX 1 anmple_EM_Panel_ELA_vx

b. Select File » Import Bin Set to open the Import Bin Set dialog box.

c. Navigate to, then select, the appropriate GM_Bins_CLA_vX.ixt file.

i Impart Bin Set

Look in: GeneMapper_Analysis setti... £

"\,3; |2 Example_GM_AM_CLA vixml
:‘a . Example GM_Bins_CLA_wX.ixt

Recent Items D Example_GM_Panel_CLA vt
=| Example_GM_Plot_Set_CLA vX.txt
- = Example_GM_SizeStd_CLA_wvXoml
Desktop =| Example_GM_Table_Set_CLA_vi.txt

File name: Example_GM_Bins_CLA_w¥. txt Import

Documents Files of type: All Files " Cancel
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6. (Optional) View the imported panels and bins in the navigation pane: Double-click the Identifiler
folders in the left pane.

The panel information is displayed in the right pane and the markers are displayed below it.

E Panel Manager =
File Edit Bins View
g > | WM W | W ™ | inSet: Example GM_Bins CLA WX MM ERE EEEEEEN
B---%Panel Manager ~ Universal | Maker Name [ye Colo |Min Size |Max Size |Control Alleles Mancer Matker |Analysis Method
B[ Identifiler_CLA_vX 1 Joastiiza Blus 118.0 |183.5 |13 4 0.1032
S 8 Example_GM_Panel_CLA_vX 2 D21511 Bue 1845 [2475 |30 4 |0.1087
--D851179
- pisis 3 D75820 Blus 251.0 |298.5  |10,11 4 0.0963
- D75820 4 CSFIPO Blue 302,12 |348.63 |10,12 4 0.092
- CSF1PO 5 D351358 Green [98.0  |148.0 14,15 4 0.1227
~ D351358 8 THOL Green |159.0  |205.0 8,3.3 4 0.0408
;g; . 7 D135317 Green  |205.65 250,16 |11 4 0.0993
- D18S539 8 D165539 Green  |255.3 30181 |11,12 4 0.1039
--D251338 3 D251335 Green |304.8 |370.31 |19,23 4 0.1244
- D195433 10 D195433 vellow [101.0  |148.0 14,15 4 01121
:_:gqx 11 WA Yelow |151.0 |213.5  |17,16 4 0.1245
- D18S51 12 TPOX vellow  |216.99 |260.99 |8 4 0.0638
- AMEL 13 D18551 vellow  |284.49 [350.0 15,19 4 0.1368
- D55813 vl [14 AMEL Red 060 (1140 |x g 0.0
= %Rehren:;;amples 15 D5S515 Red lza.0  |l80.0 |11 4 0.1006
16 FGA Red 708,25 |360.0 |23,2% 4 0.1303
< >
Ok Cancel Apply

7. Click Apply, then click OK to add the panel and bins to the GeneMapper™ Software database.

IMPORTANT! If you close the Panel Manager without clicking Apply, the panels, bin sets, and
marker stutter are not imported into the software database.

Import the size standard

Import the latest size standard from the website into the GeneMapper™ Software database:

1. In the GeneMapper™ Software, select Tools » GeneMapper Manager.

2. In the GeneMapper Manager window, select the Size Standards tab.
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O

3. In the Size Standards tab, click Import.

= GeneMapper Manager X
Projects Analysis Methods Table Settings
Plot Settings Cluster Plot Settings Matrices Size Standards SNP Sets Report Settings
Marme Size Standard Dye [Last Saved [Owner Type
ShPlex_48plex_vl Crange 2003-0%-26 11:16:34.0 |gm Basic/Advanceq A
GSE00LIZ Orange |2008-06-27 11:03:44.0 [gm Basic/dvancer
GSE0OLIZ+Marmalization | Orange 2008-06-27 10:59:54.0 |gm Basic)fdvanced
G5S00R.CN Red 2008-04-17 14:55:46.0 |am Basic/Advanced
GS500(-35,-250,-340 R 0K Red [2008-06-11 17:04:14.0 am Biasic/ fdy ance
G5500§-35,-250,-340)LIZ | Ovange |2008-04-17 14:59:07.0 |gm Basic/advanceq
G5S00{-250)R0% Red 2008-04-17 14:56:15.0 |gm Basic/Advanced
GSS00(-250)L1Z Orange 2002-08-20 13:02:36.0 |gm Basic)Advanceq
GS400HDROY Red [2002-08-20 13:02:36.0 [gm Basic/Advance
| P e e T e OO O 0 L e AT 0 Racicd v
[«
Mew... Open. .. Save As... Impurtsql’*‘%_ Export...
g

4. Navigate to, then select, the appropriate GM_SizeStd_CLA_vX.xml file you obtained in “(If needed)
Download newer versions of panel and bin files” on page 65.

™ Import Size Standard Method =

Look in: GeneMapper_Analysis settings w EF

P /=] Example_GM_AM_CLA vXxml
%ﬂ Example_GM_SizeStd_CLA_vX.xml
Recent Items
- File name: Example_GM_SizeStd_CLA_vX.xml Import
Desktop Files of type: | %ML Files (= xml) v Cancel

5. Click Import.

6. Click Done.

Import analysis method
1. In the GeneMapper™ Software, select Tools » GeneMapper Manager.
2. In the GeneMapper Manager window, select the Analysis Methods tab.

3. In the Analysis Methods tab, click Import.
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4. Navigate to, then select, the GM_AM_CLA_vX.xml file for your instrument type that you obtained in
“(If needed) Download newer versions of panel and bin files” on page 65.

i Import Analysis Method e
Look in: GeneMapper_Analysis settings e fj(
oo E Example_ GM_AM_CLA_vXxml
=E = Example_GM_SizeStd_CLA_vXxml

Recent Items

Desktop

File name: Example_GM_AM_CLA_vX.xml Import

Files of type: | %ML Files (=.xml) w Cancel

5. Click Done.

Import table settings and plot settings
1. Start the GeneMapper™ Software, then log in with the appropriate user name and password.
2. Select Tools » GeneMapper Manager.
3. In the Table Settings tab, click Import.

4. Navigate to, then select, the appropriate GM_Table_Set_CLA_vX.xml file you obtained in “(If
needed) Download newer versions of panel and bin files” on page 65.

5. Click Import.
6. Repeat for plot settings.

7. Click Done.

70 CLA Identifiler™ Plus and Identifiler™ Direct PCR Ampilification Kits User Guide



Chapter 6 Analyze data with GeneMapper™ Software M
Create a project and analyze sample files with GeneMapper™ Software |~

Create a project and analyze sample files with
GeneMapper™ Software

1. If a project is currently open, select File » New Project, then select Generic.

= New Project b

Project Type

() Microsatellite
() SNaPshot®
() OLA Analysis
(") SMPlex™

) AFLP

K Cancel

2. In the Project window, select File » Add Samples to Project, select the folder that contains the
sample files, click Add to List, then click Add.

™ Add Samples to Project e
Edit View

Files GM Database Samples To Add:
~ [#- | Example data files

¥ Metwork
I This PC
-

| | Example data

(=S cample data files

----- u A3 Sample_01.fsa
b u B3_Sample_02.fsa
b L.] C3_PosCirl_03.fsa
|| D2_NegCtrl_04.fsa

------ | | E3_Ladder_05.fsa

Add To List ==

Clear Add id & Analyze Cancel
Options...

3. Select the table setting that determines the columns that are displayed in samples table and
genotypes table: Click the arrow next to the Table Setting list, then select the setting.

Table Setting: | | Example Table Settings \é\ﬂl
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4. Apply analysis settings to the samples in the project:

a. Click the Sample Type field in the first row, then Samples

select the appropriate Sample type Statuz | Sample Mame Sample Type |4
Repeat for each sample. 1 G |sampleor s N

2 & Sample02 EEE G

IMPORTANT! You need at least 1 allelic ladder in 3 % |samplez | oouve Controffy

. Alelic Ladder |-

the project. ¢ | sample0d  lorimerFocus |

5 13 Samples Megative Contrd

Repeat for the Analysis Method, Panel, and Size
Standard fields. Select the objects you imported in “Set up the GeneMapper™ Software for
CLA analysis (before first use of the kit)” on page 63.

IMPORTANT! Analysis method is instrument-specific. Ensure that you select the appropriate
analysis method for the sample files in the project.

. If this is the first time the analysis method is used: Double-click the analysis method in the

first row, click the Allele tab. Select the bin set you imported in “Set up the GeneMapper™
Software for CLA analysis (before first use of the kit)” on page 63.

Fill in remaining rows.

Note: You can fill in the first row, click the column header to select all rows, then use Ctrl+D
to fill down remaining rows.

5. Click [J» (Analyze), enter a name for the project (in the Save Project dialog box), then click OK to
start analysis.

The status bar displays the progress of analysis as a completion bar.

The table displays the row of the sample currently being analyzed in green (or red if analysis
failed for the sample).

When analysis is complete, the SQ field displays a PQV result, and the Genotypes tab is
available.

Samples Genotypes

Statuz | Sample|Sample Type | Analysis Method |Panel Size Standarc | 5Q Wyell
1 A Sample Example CLA Ar | Example_Cl|Example CLA, 0 A0
2 B Sample Example CLA Ar | Example_Cl|Example CLA B
3 oy Sample Example CLA Ar | Example_Cl|Example CLA, cm
4 Ol Sample Example CLA Ar | Example_Cl|Example CLA ulny}
5 E1 Sample Example CLA Ar | Example_Cl|Example CLA, EO1
5 F1 Sample Example CLA Ar | Example_Cl Example CLA F1
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Review analyzed results in the sample and genotypes table

1. If you have not already done so, select the table setting that determines the headers that are
displayed in sample and genotype plot: Click the arrow next to the Table Setting list at the top of
the screen, then select the setting.

2. In the samples table, examine the SQ (sizing quality) result.

Genotypes

Status |Sample File Sample|Sample Type | &nalysis Method |Panel Size Standarc |Run Mame Fun Date & Time S0
1 A1_A1_Sample_2 A1 Sample Example CLA &r |Example_Cl Example CLA |GF SeqStudio | 2015-08-11 15:38:51 o
2 B1_B1 _Sample_2|B1 Sample Example CLA Ar |Example_Cl|Example CLA |GF SeqStudio | 2018-06-11 15:38:51
3 C1_C1 _Sample_2 | C1 Sample Example CLA Ar |Example_Cl|Example CLA |GF SeqStudio |2015-06-11 15:35:51
4 [ _B1 _Sample_2 |01 Sample Example CLA Ar |Example_Cl|Example CLA |GF SeqStudio |2015-06-11 15:35:51
5 E1_E1_Sample_21|E1 Sample Example CLA Ar |Example_Cl|Example CLA |GF SeqStudio [2015-06-11 17:37:52

3. Click the Genotypes tab, then scroll to the right to examine the PQV flags (see “About PQVs
(Process Quality Value symbols )” on page 79.

Note: To change the sort order or to display additional PQVs, click @ (Table Settings), click the
Sample or Genotypes tab, then select additional PQVs.

Samples

Sample File Samg | Panel arker Alele 1 |allele 2 |Size Size 2 Height 1 |Height 2 |PHR | &N
A1 _481 Sample_2 (A1 | Example_CLA_Pa | AMEL

HE_HE_Sample_21|HE  |Example_CLA_Pa | AMEL

A1_A1 _Sample_2 |A1 | Example_CLA_Pa|CSF1PO
C4_C4_Sample_2|C4  |Example_CLA_Pa|CSFIPO |9 11 29506 [30308 |2309 52490
C5_C5_Sample_21|C5  |Example_CLA_Pa|CSFIPO |9 11 29512 |[303.07  [3036 6126

| e e =

00 0O :

Examine low-quality sizing results

Before proceeding, ensure that you have selected the correct size standard and analysis method (which
may be instrument-specific) for the data you are analyzing.

View data collection settings

1. In the Project window, select a sample in the sample table, then select View » Sample Info.
Scroll down to view all settings.

CLA Identifiler™ Plus and Identifiler™ Direct PCR Amplification Kits User Guide 73



M Chapter 6 Analyze data with GeneMapper™ Software
Y, Examine low-quality sizing results

Info  RawData EFT Data

Sample Information

Sample File : Al Rl Sample 20120611
Sample Origin Path : D:W\Customer Data\Mart
Jackson‘\Al Rl Sample 20180611 153851.faa

Status Message : Good

File Source : Disk media

Size Standard Normalization : No

Error Message

Message : None

Current Settings

Sample Type : Sample

Panel : Example CLL Panel G

Size Standard : Example CLA Size Star

Matrix : None

Enalvysis Method : Example CLA Analy3is
Peak Detection Mode : Rdvanced

Analvsis range (data point) start: 2000 stop: 10000
S5izing range (bp) start: &0.0 stop: 500.0
Baseline window (data point): 33

2. To return to the Project window, click Project in the left pane.
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=
R
).

b,

'

Examine EPT and raw data

Review the EPT (ElectroPherogram Telemetry) plot to identify instrument performance issues that can
affect size quality.

Review the raw data to evaluate anomalies, the causes of poor size-calling, and to determine the start
and stop points for analysis. The start point for data analysis occurs after the primer peak and before
the first sizing peak. The stop point for analysis occurs after the last sizing peak.

1. In the Project window, select a sample in the sample table, then select View » Sample Info.

2. Click Raw Data to view the raw data plot.

Info RawData EPTData
A1_A1_Sample_20180611_153851.fsa

1] 2000 4000 =il 2000

a0000

20000

40000

3. Click the EPT tab to view the EPT plot.

Info RawData EFTData
A1 A1 Sample_20180611_153851.fsa

a 20000 40000 E0000 20000 10

1400

1200 ]

1000
200
E0O

400

200 f’f///

|

I

EP Voltage
Laser Power |

4. To return to the Project window, click Project in the left pane.
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Review size matches

1. In the sample table, select a sample with @ SQ, then click ||| (Size Match Editor).

View Tools Help

i g | El@ @ | r3 w |Table5etting:| Identifiler Direct Table Settings ~ | p =N | !

Samples  Genotypes
Status | Sample Mame Sample Type | Analysis Method Panel |Size Standard SG Lane | Wel
Sample01 Megative Contre| Example  AM__ CL|Example_ Panel E| Example  SizeStd
[ Sample03 Sample Example_ AM__ CL|Example _Panel C| Example_ SizeStd
Sample04 Positive Cortrol | Example_ AM__ CLExample _ Panel  C| Example__ SizeStd
Sample0s Allelic Ladder | Example_ AM__ CL|Example_ Panel | Example _ SizeStd

mwm‘i‘b

The Size Match Editor is displayed.

360007
32000:
ZSDDD:
24000 1
ZDDUD:
1BDDD:
12DDD:
SDUU:

4000 1 S0 MEDEEIRED 28050 280 2002EREEE 0400

i} e 20 SO0 | O] EOpY EOO0

(D Primer peaks
@ Size standard peaks

2. Zoom in on the size standard peaks:
a. Place the cursor on a number in the y-axis, then click-drag to the right.

3EDDD:
32000:
28000:
24000 1
2DUDD:
1EDDD:
12000:
SDDD:

4000 1 S0 BRI 2406060 280 2008 EEEED400

0 1000 d 2000 A000 a000 EOO0
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b. Place the cursor on a number in the x-axis, then click-drag up.

26000
32000
28000
24000
20000
1000
12000

an0nn

‘wﬁ BOOME 40 8XMEHA) 24ESES0 280 300 g0
WD 200 1200 100 2000 2400 2200 2200 2600 4000 4400

You may have to repeat these steps a few times to zoom on the size standard peaks.

To unzoom to full range, double-click a number in the x-axis.

3. When the trace is zoomed and you can distinguish peaks, compare the profile you observe to the
profile for the GeneScan™ 600 LIZ™ Size Standard v2.0 (Figure 3 on page 12). Determine if all size
standard peaks are correctly labeled.

In the example below, 2 peaks were unlabeled, and all remaining peaks are incorrectly labeled.

1580
1380
11a0]
320
7201
ST 100 Mg
307

180+

T .
' ' T ) ' ) T ' ) ' ' ' e T '
1625 18EF 2083 EEEY 4@ EE23 EE2d 302% 0 FE2d 3423

4. Add or delete peaks, or change values, as needed (see “Modify size matches” on page 78).
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Modify size matches

If the software does not correctly detect size standard peaks, you can modify the size matches, then
apply the modified size standard definition to all selected samples in the project.

1. Display and zoom on the trace in the Size Match Editor (see “Review size matches” on page 76.

2. Use Figure 3 on page 12 as a reference to assign the correct sizes to the peaks: Right-click an
unlabeled peak, select Add, then double-click the correct size (in this example, 240).

Option Action

Change a size value | Double-click the size value in the trace, then select a different value.

Add a size value to | Right-click an unlabeled peak, select Add, then select a size value.

a peak Note: If you cannot select a peak, it indicates the peak is below the Peak

Amplitude Threshold in the analysis method and is not detected.

180 240
200 214

220

Add... B Select Size X

Delete 20.0 A
100.0
-y Change... Pd114.0
1 2560 27E0 2960 21120.0
140.0
160.0
180.0
200.0
214.0
|220.0
240.0

Delete a size value | Right-click a labeled peak, then select Delete.
from a peak

Override the SQ After you correct all size assignments, click Override SQ.

3. Click Apply.

4. Reanalyze samples to apply the new settings.
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Modify the analysis settings

For a description of analysis settings, click @, then search for Analysis Method Editor. View the help
topics for Microsatellite settings.

1. In the Project window, double-click the analysis method for the sample of interest.

2. Modify the settings.
The following settings are recommended for CLA data analysis. Modify other settings as needed.

CLA Identifiler™ Plus kit and CLA Identifiler™ Direct kit
Analysis parameter
SeqStudio™ Flex, SeqStudio™, 3500 3730
Baseline Window Size 51 (default) 51 (default)
Peak Window Size 15 (default) 11
Smoothing Light (default) Light (default)
Size Calling Local Southern (60-460) Local Southern (60-460)

3. Click OK.

4. Reanalyze samples to apply the new settings.

Adjust Size Quality Flag ranges
1. In the Project window, double-click the analysis method for the sample of interest.
2. Click the Quality Flags tab.

3. Adjust the settings as needed.

For definitions of PQVs, click @, then click the Search tab, type the PQV name, then click List
Topics.

4. Click OK.

5. Reanalyze samples to apply the new settings.

Examine low-quality genotyping results

About PQVs (Process Quality Value symbols | .. &)

PQVs are flags that reflect the quality of results. ; %, and @ are triggered if a peak does not meet
expected thresholds.

Thresholds are set in the Peak Quality and Quality flags tabs in the analysis method.
For definitions of PQVs, click @, then click the Search tab, type the PQV name, then click List Topics.
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Review PQVs of samples with Suspect and Low Quality GQ or PQV values

1.

Click the Genotypes tab, then scroll to the right to examine the PQV flags (see “About PQVs
(Process Quality Value symbols )” on page 79.

Note: To change the sort order or to display additional PQVs, click m (Table Settings), click the
Sample or Genotypes tab, then select additional PQVs.

Samples { Genotypes

Sample File Samg |Panel darker Alele 1 |allele 2 |Sized Size 2 Height 1 |Height 2 |PHR | &N
A1_A1 _Sample_2 |A1  |Example_CLA_Pa| AMEL

HE_HE_Sample_21|HE  |Example_CLA_Pa| AMEL

A1_&1_Sample_2 |A1 | Example_CLA_Pa | CSF1PO
C4_C4_Sample_21|C4  |Example_CLA_Pa|CSFIPO |9 11 29506 [303.08 [2309 5200
C5_C5_Sample_21|C5  |Example_CLA_Pa|CSFIPO |9 1 29512 |[303.07 (3036 6126

0000

L e R R

2. To view the electropherogram for a marker, select the rows in the table that correspond to the

marker, then click [iiil (Display Plots).

Figure 13 shows a @ GQ result that is caused by:
* A peak height ratio that does not meet the threshold (PHR PQV).
® The detection of 3 peaks in the marker (AN PQV).

Sample File Sample Name Fanel tar ker as EIN |FHR |LFH |AHN GO
AZ_A2 Sample_2 | A2 Example_CLA_P:|D2251045 | | | | | |0 I
|D2251045
73 a7 83 401 103 05 107 109 111 413 M5 MF M3 421 123 125
2000 ¥ t t } t t t t t t t t t t t t t t t t t t t t t t t t t t t t
4000 4
I:I 1 1 1
12 15 16
10248 11142 [11437
8224 578 7787

Figure 13 Example 1

3. As needed, edit alleles. For information, click @, search for Sample/Genotypes Plot, then click

80

List Topics. Double-click the Sample/Genotypes Plot topic, then click Modifying Alleles.
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| -

X

))
e

Display and zoom on sample plots

1. To view the electropherogram for a sample, click the sample in the sample table, then click

(Display Plots).

i Samples Plot
File Edit View Toocls Alleles Help
Plot Setting: Plot Settings

A | | e s |

Sample File

@ |(ress ) WEL EmmE |

Sample Name Fane=l as 50

AZ_AZ Sample_ 20120611 _193823 fsa AZ Example_CLA_Panel G | E | E
[D351358 | [wtia |  [D165539 |
EE) 115 155 195 235 2745
20000 +
D Al i Al
{ Mo roorm for label = }
4
AZ_AZ Sample_ 20120611 _193823 fsa AZ Example_CLA_Panel G E E
[A... | [DBST17Y [D21511 | [D18551
EE) 115 155 195 235 2745
0000 + ' i i I i
20000 +
S R 1 i A L
Mo roorm for 1abels
4
AZ_AZ Sample_ 20120611 _193823 fsa AZ Example_CLA_Panel G E E
[D25a3 [D195433 |[THA | FGA
EE) 115 155 195 235 2745
20000 +
o L ‘l A i Rl LA

Mo room for 1abels

Note: To show fewer traces on a screen and make room for peak labels, change the Panes setting

to 2.

For more information on the samples plot, select Help » Contents and Index.

CLA Identifiler™ Plus and Identifiler™ Direct PCR Amplification Kits User Guide

81



82

Chapter 6 Analyze data with GeneMapper™ Software
Display and zoom on sample plots

0
2000

1200
00
1400
200
4000
aoo
E00
400

200

|Eg;5j GeneMapper® Software Online Help
.

Hide Back Forward Print

¥ Appli
Contents l Index ] Search ] h% Bigfysetgms P
----- [£] Computer Requirements Samples/Genotypes Plot
----- @ Supported Instruments and Softw
..... [] New Features in v5 The Samples and Genotypes Plots allow you to display el
[]__@ Getting Started de_zta and perform a variety of tasks. The tab,i’tab_le that is
.48 Setting Up Analysis window (the Samples or Genotypes tab) determines the |
' : uses to display electropherogram data.
[]--Q Anahyzing a Project
-4 Examining Data Mote: To display the Samples or Genotypes Plot, select’
- Creating and Edting Reports in the GeneMapper window, then click [iil] (Analysis » Dis
=@ Additional Information
- Software and Database Mairtens You can use the Samples/Genotypes Plot to:
- Troubleshooting
[]..@ Glossary >IZ:is.|:>lIE|\fr electropherogram plots Labels
[]..@ Websites »Modify the plot )Dglete labels .
----- [3] Contacting Life Technologies >Zoom the plot >Display the sllele hist
_____ @ Trademarks Bins >Malc,z room for labels
»Add bins >Maodify labels
»Delete bins Genotype Calls
>Edit bins >Modify alleles
*Modify bins >Rename peaks

2. Select the plot setting that determines the headers that are displayed in sample and genotype plot:

Click the arrow next to the Plot Setting list at the top of the screen, then select the setting.

3. To zoom on the plot, select View » Zoom, or:

* To zoom on the x- axis, place the cursor on the x-axis at the top of the plot, then click-drag to
the right.

[D3... WA ] [D1...]C... | [D351358 | | [D165539 |[CSF1PO | [POX |
200 440 100 140 180 220 280 300 340 380
—\ 2000
f 1
1800
1600
1400
1200
1000
o E00
0]
400
1 J H
J . i L AN 1 9 I { D
11 1 I I
al 17 n12 4l 17 4l 15 4l 12 al 11 al &
=z 132,64 (4 22§ [z 257 60| QO4E1.00 =x 132 A4 5 =x 174 22|15 =z 257 6971 sz 302.94 5% 351.90
bt 14540 B3 |t 2458 (61 D134 it 14540 bt 2135 # it $4.55 bt 16761 [t 10134
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* To zoom on the y- axis, place the cursor on the 0 y-axis, then click-drag up.

i | 11} |
al 17 4l 15 4l 12 al 11 al &
cx 132 64 (3 cx 174 22|15 ez 257 6271 ez 202,94 ez 251.90
(bt 14540 it 2123 B [ht 2458 bt 16761 (bt 10134
a0 - AL < Za +-11) =511 Tt
00
500
400
300
200
100 JML
. Ul ! i
al 17 4l 15 4l 12 al 11 al 2
sz 122,643 cz 1742215 sz 257 69|71 sz 302,94 sz 351.90
14540 FIVERN ] 2458 1a7al 10134

* To unzoom double-click the x-axis.

4. To close the sample plot, click the X in top-right corner of the screen.

Display and zoom genotype plots
1. In the project window, click the Genotypes tab.

2. If you have not already done so, select the plot setting
that determines the headers that are displayed in
sample and genotype plot: Click the arrow next to the
Plot Setting list at the top of the screen, then select
the setting.

Samples  Genoty

Status

1

Sam}\ a
PN | =5

3. To view the electropherogram for a marker, click a rows in the table that correspond to the marker,

then click [jill (Display Plots).
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4. To zoom on the plot, select View » Zoom, or:

* To zoom on the x- axis, place the cursor on the x-axis at the top of the plot, then click-drag to

the right.
o1 ]C. [D351358 | | [D165539 |[CSFIPG | PO ]
0 200 480 100 140 180 220 2E0 300 240 380
2000 —\ q h 2000
1800 \ﬂf 1200
1800 1600
1400 1400
1200 1200
000 000
a00 a0
EOO BO0O
400 400
200 200 L ‘\
0 ) . u N1 D bt Wb
al 17 n12 4l 17 4l 15 4l 12 al 11 al &
oz 13264 |4 22§ |z 25760 |0 04 51,00 =z 132 64 5 =x 174 .22[15 2x 257 6971 53 304.04 53 351.90
bt 14540 P3|t 2458 (61 D134 it 14540 it 5123 # [t G458 it 16761 [t 10134

* To zoom on the y- axis, place the cursor on the 0 y-axis, then click-drag up.

i | TN I Il

a 0wl

al 17 4l 15 al 12 al 11 4l 8
=% 132,643 sz 174 22|15 sz 257697 55 302.94 5% 351.90
[t 14540 5123 B 8458 it 16761 it 10134
=11 AL A 0 Laun LA &1L LTI
EOO
500
400
300
200
100 JML
: i H U
al 17 41 15 4l 12 al 11 4l &
cx 132643 sz 174 22|15 ez 257 69[.T1 cx 302.94 sz 351.90
it 14540 it 3123 B [t 5458 it 16761 it 10134

* To unzoom double-click the x-axis.
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Export the genotypes table

You can export the genotypes table for reference when you compare the genotypes to the ATCC
database.

1. Open the project that contains the samples of interest.

2. Click the Genotypes tab.

SamplesGenotypes

Sample File Samg |Panel arker Alele 1 |allele 2 |Size Size 2 Height 1 |Height 2 |PHR |&N
A1_81 _Sample_2 (A1 | Example_CLA_Pa | AMEL

G
1 o
2 HE_HE_Sample_21|HE | Example_CLA_Pa | AMEL o
3 A4 481 Sample_2 |A1 | Example_CLA_Pa | CSFAPO o
4 C4_C4_Sample_21|C4  |Example_CLA_Pa|CSFIPO (9 1 29506 |303.08 (2309 5240 o
5 C5_C5_Sample_21|C5  |Example_CLA_Pa|CSFIPO |9 1 29512 |303.07 |3036 B126 o

3. Display the columns that you want to export.
4. Select File » Export Table.
5. Select the export file type (the default is TXT).

6. Click Export.

Verify cell line identity using the ATCC database

Cell line identity can be verified by uploading genotypes to the ATCC cell line STR database. The ATCC
database requires you to enter genotypes for 8 specific loci, all of which are present in the Applied
Biosystems™ CLA STR Kkits.

1. In a web browser (for example, Google™ Chrome™), navigate to www.atcc.org/STR_Database.

Note: Click View our brief tutorial before starting if you are not familiar with this website.
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2. Click Please log in to search, then log in or create a user profile.

Login | Create a Profile | Quick Order | = (0 items) | USA~| 1.800.638.6597

ATCC | credibleleadstoIncredible™ Search by Keyword or Catalog m

pducts Services Standards Resources Support About

Home » STR Database

WHAT'S IN YOUR

FLASK? SEARCH THE STR DATABASE

Ir;:i-sgjlﬁErenn?ilgaatiroenn;a:rigg cell As part of our continuing efforts to characterize and authenticate the cell lines in the Cell Biology collection,
reauigite for publication and ATCC has developed a comprehensive database of short tandem repeat (STR) DNA profiles for all of our human
funding agencies a requirement cell lines. View our brief tutorial before starting.

for grant support.

Learn more »

1. 3TR Profiling Analysis
2. Matching Algorithm
3. Interrogating the Database

Please log_in to search

3. Refer to the genotypes from the file you exported, then enter the genotypes in the ATCC screen.

4. Click Matches >= 80%.

After a few minutes, a list of cell lines in the ATCC database that match the STRs present in the
test sample is displayed.

Note: The DSMZ at the Leibniz Institute maintains a database of 8-17 STR alleles for common cell
lines. To use the database, see the DSMZ instructions; go to:
https://celldive.dsmz.de/str
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Causes of extra peaks

Peaks other than the target alleles may be detected on the electropherogram. Causes for the
appearance of extra peaks include stutter products, incomplete 3" A nucleotide addition (at the n-1
position), dye artifacts, and mixed DNA samples.

Stutter definition

Stutter is a well-characterized PCR artifact that refers to the appearance of a minor peak one repeat unit
smaller than the target STR allele product, or less frequently, one repeat larger (Butler, 2005; Mulero et
al., 2006). Sequence analysis of stutter products at tetranucleotide STR loci has revealed that the minus
stutter product is missing a single tetranucleotide core repeat unit relative to the main allele (Walsh et
al., 1996).

Plus-stutter is normally less frequently observed than minus-stutter in STR loci with tetranucleotide
repeats.

For the STRs in the CLA Identifiler™ Plus and Identifiler™ Direct PCR Amplification Kits (tetranucleotide
repeats), minus stutter peaks can be observed at 4 bp below an allele peak. Plus stutter peaks can be
observed at 4 bp above an allele peak.

5 — GATA

3" ——| CTAT [—| CTAT [—{ CTAT [——

1 2 3

GATA

Figure 14 Plus stutter is caused by slippage in the top DNA strand
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Stutter peak analysis settings

The proportion of the stutter product relative to the main allele (percent stutter) is measured by dividing
the height of the stutter peak by the height of the main allele peak.

3’ A nucleotide addition peak definition

Many DNA polymerases can catalyze the addition of a single nucleotide (predominantly adenosine) to
the 3’ ends of double-stranded PCR products (Clark, 1988; Magnuson et al., 1996). This nontemplate
addition results in a PCR product that is one nucleotide longer than the actual target sequence. The
PCR product with the extra nucleotide is referred to as the “+A” form.

Artifact peak definition

Artifacts and anomalies are seen in all molecular biological systems. Artifacts are typically reproducible.
Anomalies are non-reproducible, intermittent occurrences that are not observed consistently in a
system (for example, spikes and baseline noise).

Distinguish stutter from contamination by unrelated cells

Contaminating, unrelated cells may display STR peaks that are size N-1 from the dominant cell type
and may be confused with a stutter peak. Therefore, it is important to examine all loci to accurately
determine whether a cell culture is contaminated or not contaminated. To help distinguish stutter from
contaminating cells, note the following:

* All alleles of a contaminating cell are unlikely to display the stutter phenotype.

* A contaminating cell is likely to display minor peaks in other loci that are not N-1 and cannot be
explained by stutter.

Stutter peak analysis settings

The parameters are used to identify and label stutter peaks for a marker in an electropherogram.

Parameter Description Location

Repeat unit Number of bases in the repeat unit for the designated marker. For example, a tetra | Panel
repeat unit contains 4 bases. Manager

Can be used to determine the number of basepairs from an allele peak at which
stutter may be observed.

Stutter ratio Ratio of secondary peak to allele peak below which a peak is considered to be Analysis
stutter and is filtered (is not labeled). method Allele
tab

The GeneMapper™ Software provides settings for minus and plus stutter peaks.

If Use marker-specific stutter ratio if available is selected, the minus stutter ratio in
the Panel Manager is used instead of the minus stutter ratio in the analysis method.

Note: The CLA analysis method (Allele tab) specifies Use marker-specific stutter
ratio.
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(continued)

Parameter Description Location
Stutter Size window around an expected stutter peak (because a stutter peak may not Analysis
distance migrate at an exact size). method Allele

tab

Example: A stutter distance of 3.25 to 4.75 specifies a + 0.75 bp window around the
possible —4 bp stutter peak.

The GeneMapper™ Software provides settings for minus and plus stutter peaks.

Stutter filter
(not a setting) | the stutter ratio in the analysis method or Panel Manager, the peak is filtered (not

If a peak is within the stutter distance, and the stutter-to-allele peak ratio is below NA

labeled in the electropherogram).

Note: To be analyzed, a peak must exceed the Peak Amplitude Threshold in the
analysis method Peak Detector tab.

Guidelines for troubleshooting and data interpretation CLA

* To investigate an SQ @ (sizing fails), perform the procedures in:

— Microsatellite Analysis Software —“Examine low-quality sizing results” on page 51.

— GeneMapper™ Software—“Examine low-quality sizing results” on page 73.

For more information, see the following sections in this chapter.

To investigate an GQ @ (genotyping fails), perform the procedures in:
- Microsatellite Analysis Software —“Examine low-quality genotyping results” on page 55.

— GeneMapper™ Software— “Examine low-quality genotyping results” on page 55.

For more information, see the following sections in this chapter.

For information on the PQV symbols that are displayed in the samples or genotypes table (

@) sce:

— Microsatellite Analysis Software —“About PQVs (Process Quality Value symbols )” on page 55.
— GeneMapper™ Software—“About PQVs (Process Quality Value symbols )” on page 79.

For more information, see the following sections in this chapter.

To be detected and labeled, a stutter peak must exceed the Peak Amplitude Threshold in the
analysis method and the stutter ratio in the panel. The default stutter ratio filter values that are
provided in the panel were determined by extensive studies. However, it is not unusual to observe
stutter peaks that are above the stutter ratio filter values. If you consistently observe a stutter peak
for a marker, you can create a filter to prevent the peak from being labeled (as determined by your
standard operating protocol).

Stutter peak amplitude is additive. Example: If an N+2 stutter peak from allele peak A migrates at
the same location as an N-2 stutter peak from allele peak B, the stutter peak height is increased.

If you run multiple allelic ladders, the allele calls are averaged for all allelic ladders in a project

( Microsatellite Analysis Software) or a folder (GeneMapper™ Software). You can re-analyze a
sample using the allelic ladder that is in the closest well position to the sample for possibly
improved genotyping results. (To do so, either remove all but the allelic ladder of interest from the
project and re-analyze, or create a new project with the sample and the allelic ladder.)
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Appendix A Troubleshooting
D3S1358 marker shoulder and stutter peak examples (N+1, N-4, and N+4)

* To determine if a sample peak is expected at a specific size in a marker, display the
electropherograms for the sample, size standard, and allelic ladder.

* Before you conclude that a peak is a possible microvariant (after ruling out that it is a stutter peak
or artifact), confirm that the peak reproducibly migrates at the observed bp (by running samples in
duplicate or by repeating the electrophoresis run).

* [f you observe unexpected stutter peaks across all profiles, repeat amplification (ensure correct
buffer pH, thermal cycling settings).

D3S1358 marker shoulder and stutter peak examples (N+1,
N-4, and N+4)

Note: A stutter peak is filtered (not labeled) if it is 1) above the Peak Amplitude Threshold in the
analysis method Peak Detector tab; 2) within the Stutter Distance range in the analysis method Allele
tab; 3) above the stutter ratio (% of allele peak) in the panel.

15 L 14 17 13
124 062581 128 96 13296 136 .95
11039 25 220 1195 EIED

(@ Allele peak 15
@ OL shoulder peak (+1 bp from allele peak 15)

@ Labeled plus stutter peak (+4 bp from allele peak 15). It is not filtered (and is therefore labeled) because no plus
stutter distance is set in the GeneMapper™ Software analysis method.

@ Labeled minus stutter peak (-4 bp from allele peak 18). It is not filtered (and is therefore labeled) because the stutter
ratio exceeds the stutter ratio set in the panel. [Stutter ratio for the labeled 17 peak: 1195/9631=0.1240; Stutter ratio
for the marker in the panel: 0.1227]

(®) Allele peak 18
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Appendix A Troubleshooting
POP™ polymer-specific artifact examples (N-1 and N+1 shoulder peaks)

POP™ polymer-specific artifact examples (N-1 and N+1
shoulder peaks)

When using POP-7™ Polymer or when using the SeqStudio™ Genetic Analyzer Cartridge, N-1 and N+1
shoulder peaks are sometimes observed in the D7S820 and AMEL markers.

Note: A stutter peak is filtered (not labeled) if it is 1) above the Peak Amplitude Threshold in the
analysis method Peak Detector tab; 2) within the Stutter Distance range in the analysis method Allele
tab; 3) above the stutter ratio (% of allele peak) in the panel.

259 21 263 265 267 ] 215 2 273 a

oL i oL oL 1 oL
26300 [264.08) (26312 27910 [2B0.16) 28113
557 10171 13 474 602 278

Figure 15 D7S820 marker

(D Allele peak 8

@ Filtered minus stutter peak (-4 bp from allele peak 8)
@ OL shoulder peak (-1 bp from allele peak 8)

@ OL shoulder peak (+1 bp from allele peak 8)

(® Allele peak 12

@ Filtered minus stutter peak (-4 bp from allele peak 12)
@ OL shoulder peak (-1 bp from allele peak 12)

OL shoulder peak (+1 bp from allele peak 12)
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Appendix A Troubleshooting
POP™ polymer-specific artifact examples (N-1 and N+1 shoulder peaks)

01 103 105 107 109

Figure 16 N+1 shoulder peaks in SeqStudio™ Genetic Analyzer data AMEL marker

(D Allele peak
@ N+1 shoulder peak
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Appendix A Troubleshooting
D195433: off-ladder alleles caused by dye pullup

D19S433: off-ladder alleles caused by dye pullup

If you observe an unexpected or off-ladder allele in the genotypes plot, note the bp/height values for the
peak, then evaluate the peak in the samples plot with all dyes displayed. If the peak appears under an
allele peak +0.5 bp, it may be a pull-up peak.

In this example, the OL peak in the yellow dye (displayed in black in the software) is at the same bp as
the green dye peak, and therefore is possibly a pull-up peak instead of a true DNA peak.

|l

11792 12180 12504 I I |
b s i Of m ¢ Atk s

@ Genotypes plot
@ Samples plot with all dye channels displayed showing that the OL peak in the yellow dye may be caused by dye pull-up from
the green dye channel.

@ Sizing table (with samples plot open, select View » Tables » Sizing Table »)

General troubleshooting

The Microsatellite Analysis Software uses colored circles @ as quality indicators. The GeneMapper™
Software uses colored shapes ;. @ as quality indicators.

The troubleshooting information in the following section refers to colored circles © @, but the
information applies to both the Microsatellite Analysis Software and the GeneMapper™ Software.

Observation Possible cause Recommended action

The correct size standard is not | If SQ is @ for all samples, ensure that
selected. the correct size standard is selected in the
setup tab ( Microsatellite Analysis Software) or
sample table (GeneMapper™ Software). See:

SQ . (sizing fails)

* Microsatellite Analysis Software—page 52
and page 52

* GeneMapper™ Software—page 76 and
“Modify size matches” on page 78
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Appendix A Troubleshooting
General troubleshooting

Observation

Possible cause

Recommended action

SQ . (sizing fails)
(continued)

The peaks in the size standard
are not correctly labeled. See:

If SQ is @ for individual samples, examine the
size standard for the samples and update if
needed.

* Microsatellite Analysis Software—page 52
and page 52

¢ GeneMapper™ Software—page 76 and
“Modify size matches” on page 78

Size standard was not added
to the samples.

Prepare samples again, make sure to add size
standard.

GQ . (genotyping fails)

The incorrect panel and bins
are specified.

Select the correct panel and bins. See:
* Microsatellite Analysis Software—page 48
* GeneMapper™ Software—page 71

No allelic ladder is specified for
the project.

Change at least one allelic ladder in the
project to Sample Type Allelic Ladder. See:

* Microsatellite Analysis Software—page 48
* GeneMapper™ Software—page 71

You manually created the
analysis method, panel, and
bins in the GeneMapper™
Software.

IMPORTANT! Use only panel
and bin TXT files that are
provided by Thermo Fisher
Scientific. If you use panel and
bin files that you create in the
GeneMapper™ Software, you
may see off-ladder alleles.

Change at least one allelic ladder in the
project to Sample Type Allelic Ladder. See:

* Microsatellite Analysis Software—page 48
* GeneMapper™ Software—page 71

SQPQVis or . and
peaks do not contain size
labels

The fragment sizes of the

size standard definition do not
match the positions of the
detected peaks.

Examine the size standard. See:
* Microsatellite Analysis Software—page 52
* GeneMapper™ Software—page 76

SQPQVis or . and one
or more peaks are miscalled

Peak detection threshold
associated with the size
standard is set too high or low.

Adjust the analysis method so that the Peak
Amplitude Threshold associated with the size
standard is greater than the height of the
miscalled peak.

SQPQVis or . peaks
are clear and distinguishable,
but have low signal strength

Peak detection threshold
associated with the size
standard is set too high or low.

Adjust the analysis method so that the Peak
Amplitude Threshold associated with the size
standard is greater than the height of the
miscalled peak.

Electrophoresis or pipetting
error

Adjust the analysis method so that the Peak
Amplitude Threshold associated with the size
standard is greater than the height of the
miscalled peak.
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Appendix A Troubleshooting
General troubleshooting

Observation

Possible cause

Recommended action

SQPQVis or . because
size standard peaks occur
within a primer peak

The smallest peaks of the size
standard can appear within the
primer range.

Create and analyze the data using a custom
size standard that does not include the
undetectable peak.

SQPQVis or .,

size standard peaks are

clear and distinguishable, but
consistently have low signal
strength

Incorrect concentration of size
standard in sample loading
reagent.

Increase the concentration of size standard
added to subsequent runs.

Incorrect injection settings.

Review the injection settings of the run
module for errors.

SQ PQVis or . and size
calling errors occur for different
samples on the same capillary
over multiple runs

Defective capillaries/arrays.

Troubleshoot the defective capillaries/arrays.

SQ PQVis or .

size standard peaks are

clear and distinguishable, but
consistently have low signal
strength, and sizing failures
occur in a regular pattern (the
same wells fail repeatedly)

Electrophoresis or pipetting
error.

Reinject the sample. If needed, prepare fresh
sample.

Elevated stutter peaks or
spurious peaks are observed

DNA input is too high.

Prepare samples with lower DNA input, then
re-run.

Allelic dropout or imbalance in
samples and size standard

DNA input is too low.

Prepare samples with increased DNA input if
possible, then re-run.

Incorrect thermal cycling
parameters.

Use the thermal cycling parameters
recommended in Chapter 2, “Perform PCR:
CLA Identifiler™ Plus kit” or Chapter 3,
“Perform PCR: CLA Identifiler™ Direct kit”.

Use of a thermal cycler that

is not listed in “Instrument

and software compatibility” on
page 15. Other thermal cyclers
may have different thermal
properties/ramp rates.

Use only thermal cyclers listed in “Instrument
and software compatibility” on page 15.

Confirm proper use of thermal cycler
accessories such as compression pad, tray
and retainers.

Allelic dropout or imbalance in
samples only

PCR inhibitors in samples.

Prepare samples with decreased DNA input to
reduce inhibitor concentration, then re-run.

Incorrect allele calls

Incorrect peak amplitude
thresholds in analysis settings.

Adjust the analysis method.

Spikes and other non-
reproducible, anomalous peaks

Use of expired reagents on
the instrument, or instrument
maintenance required.

Perform routine instrument maintenance.

Replace expired reagents.
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Materials required but not supplied

Sample preparation required materials .......... ... e 96
Thermal cycler required materials .. ... .o 97
Capillary electrophoresis instrument required materials ......... ... ... .. .. .. L. 97
Analysis software required materials . .. ... e 100
Miscellaneous required materials .. ......... .. i i e 100

Unless otherwise indicated, all materials are available through thermofisher.com. "MLS" indicates that
the material is available from fisherscientific.com or another major laboratory supplier.

Catalog numbers that appear as links open the web pages for those products.

Sample preparation required materials

Table 7 CLA Identifiler™ Plus kit

Item Source
TE Buffer [low-TE buffer; 10 mM Tris-HCI (pH 8.0) and 12090015
0.1 mM EDTA] or see “(Optional) Prepare low-TE buffer” on
page 18.
Hi-Di™ Formamide, 25-mL 4311320
Table 8 CLA Identifiler™ Direct kit
Item Source
NUCLEIC-CARD™ matrix, 1 spot MLS
NUCLEIC-CARD™ COLOR matrix, 1 spot MLS
Uni-Core™ Punch, 1.2 mm MLS
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Appendix B Materials required but not supplied
Thermal cycler required materials

Thermal cycler required materials

ProFlex™ PCR System

Item Source
ProFlex™ 96-well PCR System 4484075
ProFlex™ 2 x 96-well PCR System 4484076
ProFlex™ 3 x 32-Well PCR System 4484073
VeritiPro™ Thermal Cycler
Item Source
VeritiPro™ Thermal Cycler, 96-well A48141
(Optional) Tabletop centrifuge with 96-Well Plate Adapters MLS

Capillary electrophoresis instrument required materials

SeqStudio™ Flex Series Genetic Analyzer

ltem Source
SegStudio™ 8 Flex Genetic Analyzer (includes SeqStudio™ Flex Series Instrument A53627, A53628, or
Software) A53629
SeqStudio™ 24 Flex Genetic Analyzer (includes SeqStudio™ Flex Series Instrument A53630, A53631, or
Software) A53632
Anode Buffer Container 3500/Flex Series 4393927
Cathode Buffer Container 3500/Flex Series 4408256
Septa Cathode Buffer Container 3500/Flex Series 4410715
Capillary array 36-cm SeqStudio™ 8 Flex A49104
Capillary array 36-cm SeqStudio™ 24 Flex A49105
96-Well Standard Retainer & Base Set SeqgStudio™ Flex Series A49316
8-Tube Standard Retainer & Base Set SeqStudio™ Flex Series A49296
8-Strip Septa 3500/Flex Series 4410701
96-Well Septa 3500/Flex Series 4412614
Conditioning Reagent Kit 3500/Flex Series 4393718
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Appendix B Materials required but not supplied
Capillary electrophoresis instrument required materials

(continued)

ltem Source
DS-33 Matrix Standard Kit (Dye Set G5) 4345833
POP-7™ (960) Performance Optimized Polymer 4393714
POP-7™ (384) Performance Optimized Polymer 4393708
POP-4™ (960) Performance Optimized Polymer 4393710
POP-4™ (384) Performance Optimized Polymer 4393715

SeqStudio™ Genetic Analyzer

Item Source
SeqStudio™ Genetic Analyzer (includes the SeqStudio™ Data Collection
A35644
Software)
(Optional) SAE Administrator Console v2.0 or v2.1
Note: SAE Administrator Console v2.0 is compatible with SeqStudio™ v2.0—A46170
Data Collection Software v1.1 to v1.2.3. SAE Administrator Console v2.1 v2.1—A53717

is compatible with SeqStudio™ Data Collection Software v1.2.4.

Available on apps.thermofisher.com or

(Optional) SeqStudio™ Plate Manager v1.2 or v2.0 for download at thermofisher.com

SeqStudio™ Genetic Analyzer Cartridge v2 A41331
SegStudio™ Genetic Analyzer Cathode Buffer Container A33401
Reservoir Septa (for Cathode Buffer Container) A35640
SegStudio™ Integrated Capillary Protector A31923
Septa for SeqStudio™ Genetic Analyzer, 96 well A35641
Septa for SeqStudio™ Genetic Analyzer, 8 strip A36543
DS-33 Matrix Standard Kit (Dye Set G5) 4345833

3500/3500xL Genetic Analyzer

Item Source
3500 Genetic Analyzer (includes 3500 Series Data Collection Software) 4405673
3500xL Genetic Analyzer (includes 3500 Series Data Collection Software) 4405633
Anode Buffer Container 3500/Flex Series 4393927
Cathode Buffer Container 3500/Flex Series 4408256
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Appendix B Materials required but not supplied
Capillary electrophoresis instrument required materials

(continued)
ltem Source
Septa Cathode Buffer Container 3500/Flex Series 4410715
3500 Genetic Analyzer 8-Capillary Array, 36 cm 4404683
3500xL Genetic Analyzer 24-Capillary Array, 36 cm 4404687
3500 Genetic Analyzer 8-Capillary Array, 50 cm 4404685
3500xL Genetic Analyzer 24-Capillary Array, 50 cm 4404689
Retainer & Base Set (Standard) for3500/3500xL Genetic Analyzer, 96 well 4410228
Retainer & Base Set (Standard) for3500/3500xL Genetic Analyzer, 8 tube 4410231
8-Strip Septa 3500/Flex Series 4410701
96-Well Septa 3500/Flex Series 4412614
Conditioning Reagent Kit 3500/Flex Series 4393718
DS-33 Matrix Standard Kit (Dye Set G5) 4345833
POP-7™ (960) Performance Optimized Polymer 4393714
POP-7™ (384) Performance Optimized Polymer 4393708
Polymer, POP-7™ (96) A26073
3730/3730x/ DNA Analyzer
Iltem Source

3730x/ DNA Analyzer (includes 3730x/ Data Collection Software)

Note: The 3730 DNA Analyzer is no longer available for sale. However, you can still run the kit on a 3730 | A41046
DNA Analyzer with 3730/3730x/ Data Collection Software 4.0.

3730x/ DNA Analyzer 96-Capillary Array, 36-cm 4331244
3730x/ DNA Analyzer 96-Capillary Array, 50-cm 4331246
3730 DNA Analyzer 48-Capillary Array, 36-cm 4331247
3730 DNA Analyzer 48-Capillary Array, 50-cm 4331250
Polymer Block Cleaning Kit 4335860
3730 Running Buffer (10X) , 500 mL 4335613
Hi-Di™ Formamide 4311320
DS-33 Matrix Standard Kit (Dye Set G5) 4345833
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Appendix B Materials required but not supplied
Analysis software required materials

(continued)

Iltem Source
POP-7™ Polymer, 1 x 28 mL 4363929
POP-7™ Polymer, 10 x 28 mL 4363935

Analysis software required materials

GeneMapper™ Software

ltem Source
GeneMapper™ Software v6, Full Installation, (Windows™ 10/Windows™ 7 SP1) A38888
GeneMapper™ Software v6, Client Installation, (Windows™ 10/Windows™ 7 SP1) 4475074
GeneMapper™ Software v5, Full Installation, (Windows™ 7 SP1) A31128
GeneMapper™ Software v5, Client Installation, (Windows™ 7 SP1) A38892
Microsatellite Analysis Software

Item Source

Microsatellite Analysis Software apps.thermofisher.com

Miscellaneous required materials

Plates and tubes

ltem Source
MicroAmp™ 96-Well Tray N8010541
MicroAmp™ Reaction Tube with Cap, 0.2 mL N8010540
MicroAmp™ 8-Tube Strip, 0.2 mL N8010580
MicroAmp™ Optical 8-Tube Strip, 0.2 mL 4316567
MicroAmp™ Optical 8-Cap Strips 4323032
MicroAmp™ 96-Well Tray/Retainer Set

403081

(Adapter for 8-Tube Strip)
MicroAmp™ 96-Well Base N8010531
MicroAmp™ Clear Adhesive Film 4306311
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Appendix B Materials required but not supplied
Miscellaneous required materials

(continued)
ltem Source

MicroAmp™ Optical Adhesive Film 4311971
MicroAmp™ Optical 96-Well Reaction Plate N8010560
MicroAmp™ Optical 96-Well Reaction Plate with Barcode 4326659
Laboratory supplies

Iltem Source
Various procedures
Aerosol resistant pipette tips MLsI
Microcentrifuge tubes MLS
Pipettors MLS
Tape, labeling MLS
Tube, 50-mL Falcon™ MLS
Tube decapper, autoclavable MLS
Deionized water, PCR grade MLS
Vortex MLS

' Major laboratory supplier
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Safety

WARNING! GENERAL SAFETY. Using this product in a manner not specified in the user
documentation may result in personal injury or damage to the instrument or device. Ensure that
anyone using this product has received instructions in general safety practices for laboratories and
the safety information provided in this document.

. Before using an instrument or device, read and understand the safety information provided in the
user documentation provided by the manufacturer of the instrument or device.

. Before handling chemicals, read and understand all applicable Safety Data Sheets (SDSs) and use
appropriate personal protective equipment (gloves, gowns, eye protection, and so on). To obtain
SDSs, visit thermofisher.com/support.
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Appendix C Safety
Chemical safety

Chemical safety

/W\. WARNING! GENERAL CHEMICAL HANDLING. To minimize hazards, ensure laboratory personnel
&~ read and practice the general safety guidelines for chemical usage, storage, and waste provided
below. Consult the relevant SDS for specific precautions and instructions:

. Read and understand the Safety Data Sheets (SDSs) provided by the chemical manufacturer
before you store, handle, or work with any chemicals or hazardous materials. To obtain SDSs, see
the "Documentation and Support" section in this document.

. Minimize contact with chemicals. Wear appropriate personal protective equipment when handling
chemicals (for example, safety glasses, gloves, or protective clothing).

. Minimize the inhalation of chemicals. Do not leave chemical containers open. Use only with

sufficient ventilation (for example, fume hood).

Check regularly for chemical leaks or spills. If a leak or spill occurs, follow the manufacturer

cleanup procedures as recommended in the SDS.

. Handle chemical wastes in a fume hood.

. Ensure use of primary and secondary waste containers. (A primary waste container holds the
immediate waste. A secondary container contains spills or leaks from the primary container.
Both containers must be compatible with the waste material and meet federal, state, and local
requirements for container storage.)

. After emptying a waste container, seal it with the cap provided.

. Characterize (by analysis if needed) the waste generated by the particular applications, reagents,
and substrates used in your laboratory.

. Ensure that the waste is stored, transferred, transported, and disposed of according to all local,
state/provincial, and/or national regulations.

. IMPORTANT! Radioactive or biohazardous materials may require special handling, and disposal
limitations may apply.

AVERTISSEMENT ! PRECAUTIONS GENERALES EN CAS DE MANIPULATION DE PRODUITS
CHIMIQUES. Pour minimiser les risques, veiller a ce que le personnel du laboratoire lise attentive-
ment et mette en ceuvre les consignes de sécurité générales relatives a I'utilisation et au stockage
des produits chimiques et a la gestion des déchets qui en découlent, décrites ci-dessous. Consulter
également la FDS appropriée pour connaitre les précautions et instructions particulieres a respecter :

. Lire et comprendre les fiches de données de sécurité (FDS) fournies par le fabricant avant de
stocker, de manipuler ou d’utiliser les matériaux dangereux ou les produits chimiques. Pour obtenir
les FDS, se reporter a la section « Documentation et support » du présent document.

. Limiter les contacts avec les produits chimiques. Porter des équipements de protection appropriés
lors de la manipulation des produits chimiques (par exemple : lunettes de slreté, gants ou véte-
ments de protection).

. Limiter I'inhalation des produits chimiques. Ne pas laisser les récipients de produits chimiques
ouverts. lls ne doivent étre utilisés qu’avec une ventilation adéquate (par exemple, sorbonne).

. Vérifier régulierement I’absence de fuite ou d’écoulement des produits chimiques. En cas de fuite
ou d’écoulement d’un produit, respecter les directives de nettoyage du fabricant recommandées
dans la FDS.

. Manipuler les déchets chimiques dans une sorbonne.
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. Veiller a utiliser des récipients a déchets primaire et secondaire. (Le récipient primaire contient les
déchets immédiats, le récipient secondaire contient les fuites et les écoulements du récipient pri-
maire. Les deux récipients doivent étre compatibles avec les matériaux mis au rebut et conformes
aux exigences locales, nationales et communautaires en matiére de confinement des récipients.)

. Une fois le récipient a déchets vidé, il doit étre refermé hermétiquement avec le couvercle fourni.

. Caractériser (par une analyse si nécessaire) les déchets générés par les applications, les réactifs et
les substrats particuliers utilisés dans le laboratoire.

. Vérifier que les déchets sont convenablement stockés, transférés, transportés et éliminés en res-
pectant toutes les réglementations locales, nationales et/ou communautaires en vigueur.

. IMPORTANT ! Les matériaux représentant un danger biologique ou radioactif exigent parfois une
manipulation spéciale, et des limitations peuvent s’appliquer a leur élimination.

Biological hazard safety
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WARNING! BIOHAZARD. Biological samples such as tissues, body fluids, infectious agents,

and blood of humans and other animals have the potential to transmit infectious diseases.

Conduct all work in properly equipped facilities with the appropriate safety equipment (for example,
physical containment devices). Safety equipment can also include items for personal protection,

such as gloves, coats, gowns, shoe covers, boots, respirators, face shields, safety glasses, or
goggles. Individuals should be trained according to applicable regulatory and company/ institution
requirements before working with potentially biohazardous materials. Follow all applicable local,
state/provincial, and/or national regulations. The following references provide general guidelines when
handling biological samples in laboratory environment.

. U.S. Department of Health and Human Services, Biosafety in Microbiological and Biomedical
Laboratories (BMBL), 5th Edition, HHS Publication No. (CDC) 21-1112, Revised December 2009;
found at:
www.cdc.gov/labs/pdf/CDC-BiosafetymicrobiologicalBiomedicalLaboratories-2020-P.pdf

. World Health Organization, Laboratory Biosafety Manual, 3rd Edition,
WHO/CDS/CSR/LYO/2004.11; found at:
www.who.int/publications/i/item/9789240011311
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Documentation and support

Related documentation

Document

Publication number

Thermal cyclers

VeritiPro™ Thermal Cycler User Guide MANO0019157
ProFlex™ PCR System User Guide MANO0007697
ProFlex™ PCR System Kit Validation User Bulletin 100031595
SeqStudio™ Flex Series Genetic Analyzer
SeqStudio™ Flex Series Genetic Analyzer with Instrument Software v1.1.1 User 100104689
Guide
SeqStudio™ Flex Series Instrument Software v1.1.1 User Bulletin MANO0029757
SeqStudio™ Genetic Analyzer
SeqStudio™ Genetic Analyzer Instrument and Software User Guide (v1.2 and MANO0O018646
later)
3500/3500xL Genetic Analyzer
3500/3500xL Genetic Analyzer with 3500 Series Data Collection Software v3.3 100079380
User Guide
3500/3500xL Genetic Analyzer with 3500 Series Data Collection Software v 3.1 100031809
User Guide
3730/3730x/ DNA Analyzer
3730xI DNA Analyzer with 3730x! Data Collection Software 5 User Guide 100077621
Applied Biosystems™ 3730/3730xI DNA Analyzers Getting Started Guide 4478016
Analysis software
Microsatellite Analysis Software User Guide MANO0017825
GeneMapper™ Software 6 Installation and Administration User Guide 100079198
GeneMapper™ Software 5 Installation and Administration User Guide 4476603

Note: Version 4.1 user documentation applies to Version 5 and Version 6 software. No features have changed in

the newer versions of software.
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Application notes

(continued)

Document Publication number
GeneMapper™ Software v4.1 Installation Options User Bulletin 4403675
GeneMapper™ Software v4.1 Autoanalysis User Bulletin 4403670
GeneMapper™ Software v4.1 Reference and Troubleshooting Guide 4403673
GeneMapper™ Software v4.1 Quick Reference Guide 4403615
GeneMapper™ Software v4.1 Microsatellite Analysis Getting Started Guide 4403672

Application notes

Document url
Application note: Authenticating human cell lines using CLA IdentiFiler Download from
and CLA GlobalFiler kits on capillary electrophoresis platforms www.thermofisher.com/CLA

Case study: Matching identities of iPSCs and donors using CLA
Identifiler STR profiling kits

Application note: Confidently identify human samples using the CLA
Identifiler and CLA GlobalFiler STR kits
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